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custom_ function override get columns to view(

COLUMNS TARGET VIEW PAGE ) {

$t_columns = array();

$p_columns_target

if ( $p_columns_target == COLUMNS TARGET CSV_PAGE ) {

$t columns[] = 'id'"; // localized: 'id',

$t columns[] = 'project_id'; // 'email project’
$t columns[] = 'reporter_id'; // 'reporter’

$t columns[] = 'handler_id'; // 'assigned to'
$t columns[] = 'priority'; // 'priority’

$t columns[] = 'severity'; // 'severity'

$t columns[] = 'reproducibility'; // 'reproducibility’

$t _columns[] = 'version'; // 'version'
$t columns[] = 'projection'; // 'projection’

$t columns[] = 'category'; // 'category’

$t columns[] = 'date_submitted'; // 'date_submitted’

$t columns[] = 'eta'; // 'eta’

$t columns[] = 'os'; // 'os'

$t columns[] = 'os_build'; // 'os_version'

$t columns[] = 'platform'; // 'platform'

$t columns[] = 'view_state'; // 'view_status'
$t columns[] = 'last_updated'; // 'last_update’
$t columns[] = 'summary'; // 'summary’

$t columns[] = 'status'; // 'status’

$t columns[] = 'resolution'; // 'resolution’

$t columns[] = 'fixed in_version'; // 'fixed in_version';

51 MR R Hh 2R 7N B
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# if viewing only one Project, Add all custom fields linked to this
project

if ( helper_get current project() !'= ALL PROJECTS ) {

$t custom_fields =

custom field get linked ids(helper get current project());

foreach( $t custom fields as $t field id ) {
$t desc = custom_field get definition( $t field id );

$t columns[] = 'custom

}
b

. $t desc['name'];

if ( OFF == config get( 'enable relationship') ) {
$t columns[] = 'duplicate_id'; // 'duplicate_id'

H
} else {

$t columns[] = 'selection';

if ( $p_columns_target == COLUMNS TARGET_VIEW PAGE) {

$t columns[] = 'edit’;

}

$t columns[] = 'priority';

$t columns[] = "id";

$t _enable sponsorship = config get( 'enable sponsorship');

if ( ON == $t_enable sponsorship ) {

ST AR 5575 1 8
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$t columns[] = 'sponsorship';

}

$t _columns[] = 'bugnotes count';

$t show_attachments=
config get( 'show_attachment indicator');
if ( ON == $t show_attachments ) {

$t columns[] = 'attachment';

}

$t columns[] = 'reporter_id";

$t columns[] = 'category';

$t columns[] = 'severity';

$t _columns[] = 'status';

$t columns[] = 'last_updated’;

$t columns[] = 'summary';

}

return $t_columns;

}
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2) [ B P A =, o B g, W % T e I Tk R
s, KRR 4 40 WS DU R B AR X AN A g sl D, B

TestCase 01: 20 FH " 7AE 2k, L4 200 NI H, & § 2 7~ BRIA (20
/00, 8 FI/TU), AU FE 3L AR I H d sk BOAS 3 i i L F
F G0 1 AH N B ]

TestCase 02: FI @ik . [l & Ko Pe o) @8k 20 J5 4, A H
3 H e R AR 1000, HE X Wox (20 45/00, 8 F/51), W H
VRN T B I NIOR = RV N P VA W51

ol — CEED): 34 F: TestCase 01 55 TestCase 02 W i
f 84 Cinl @& D U5 o) 1R 2 B0 W) — ik %,

1> AR S 748 HE . AT TestCase 01, sk &i K. A5
PRI S 7 4 54l . B4 ik /2 10 /7, AT TestCase 01, ic 5% &5
X

2> U B SR T 20 J7 IR, 4B 5t & TestCase 02 [ [
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WPAT W Bl B A A T DU IR M AR AT . — . B E A
Bl o AR PE IR ) B AR g, vk it SQL B A, JF Howl Ui —
ANICRES, Al SQL i 5 5l il M 9 2 Ta) R R Y Ok AR, [ I 2R S R
A7 003K R 0 B IR, LR XA R O AN O g SR KR 90 B T R G
MR AT, = W PAT R R R o R S N B s A I O R
BEAT AT o T T & BEAS I R B vk WA R AR BL A LA SO )RR
KA LI — T .
— BE A A

Testcase 01 JH B f 3k - [f € A /" 28 30 A, WOl W on (50 45/0C,
4 FV/50) . &gk AR AT B AR B as A B 8O0 1S B0 me N I TR

Testcase 02 J Bl #iik . [ H &4 30 4. Sgi 1
i ) B ds [ 2 1 5 4% . U Rox (50 4&/00, 4 3/50). Wi AT
Ny R = RV N A T

AR A CL b9k R ), At mr DL B o S R U K Hs 15 SQL AR
T R JE MR BN SO R sk 1 SQL A B K FH 4 R Bl sk, AR
Jo F v v AR
. PBH SQL JA

4. declare
p number;

q number;
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begin

p :=15424;

q :=0;

while p<=15503 loop

select qmtools.PRPROBLEMSEQ.nextval into q from dual;

INSERT INTO PRPROBLEM ( PRPROBLEMID, PRRECORDID,
PRPBTYPEID, PRBDESCRIBE, PRESENTER, SOLVE, STAFFID,

FACTSOLVEDATE, FACTEFF, PRSTATEID, MODULEID,
CONFIRMSTAFF, CONFIRMDATE, PREFLAG, MEMO,
PREWORKLOAD,

POSITION, PBMOVEKIND, MILESTONEID, PBGRADE,

PBPINCHEFF ) VALUES (

q, p, 42, 'ertre', 'pmz5’', 'erteert’

, 5489, TO Date( '12/16/2006 12:00:00 & 7', 'MM/DD/YYYY
HH:MI:SS AM"), 33, 2, 8903

, ! ' NULL, O, 'ertret', O, 'ert'

R ELE, 0, 'CY, 3);

p :=p+l;
end loop;
end;
¥ i% SQL M A 44 S1, wWxE T K
. SQLA A 5 i i A {51 % [ 3%
T E e T F s R Tt M ~
5 SOLEIER S [ RPERS TE1 TEIEA B T2t [FEz |FEiEt
1151 Testcasell
2 TestcaselZ - :
3|52 Testcasel3

AR BN T AE BT SQL AN A A I B ] B K O N Sk, 1
HORs A2 il R i 28, A7 A Bk MK RS, o HL 2 AT X 28 SQL A
I e WA REAS AR R A .

= Wk AR
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Testcase02 ¥ T A7 15 &0 AT 58 B2, k& Testcase02 14 26 2% 5 iy
AT 58 S5 K AT IR EAT v o P BUwd B A Bk ) T LU B AT 2 AR W
A A, 1E ICTF AR AT K T 90 B It T DA s LU v vk B
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PERE X B R K X S S W ot AR AT B Th AF DL S AR B
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Rational 7£ B 3h 46 M i 4 5 N H
e X%
B Th 1 I fe WU R i 42

1. “Z#iRational Robot, #J il if Rational Suite Test Studio, Rational

TeamTest or Rational Robot

. ,:"" 123 - Rational Robot - [example]

e

208y REUSE oL d FOELELEME o N @ &
= @'-.-'erificatiu:un Paints '4Include "CheckDBHeader .sbh™ -

B2 object Data

B ObjectDataz | SUb Main
@Ohjectlﬂmpert Dim Result As Integer

@ Object Propert

'Initially Recorded: 2887-6-18 14:86:81
'Script Hame: example
Startapplication """D:\program files\Rat:

Window SetContext, "Hame=frmExistinglLogii
PushButton Click, "Hame=cmdOK'"

MlHndam fatfantaoavt "Hama=Frmkdain" LLLL)
1 | 1] L 1] »

_I_[\ Build ;"r.l Conzole f

ooood 001 |admin

RN

2. i# it Rational Administratorfl) & WK %5 7=, KA A7 M % 5=

51 MR R 2B 7S 3 17
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++ Rational Administrator
File Edit View Tools Help

B e K? r- AR R
- B Rational Administrator Mame | Location | Path | ClearQuest
- @ Projects 123 Eilaaal E:laaall...
123 AULoPSA DS Dl
ALEOPSA POMS DoilisE:.,  Duoilld..,
POMS

For Help, press F1

3. 1 it Rational Robot>k = il A [1] 5l i ji A<

Query: |Standard

MName Scripk Tvpe Descripkion
Terporary ... Gl
i+ GLI

1] 4 | Cancel Froperties. .. | Help

4. i@ if Rational Log Viewer Al Comparators >k ic 3% [0 55 i 0 iR 45

ES

51 MR R 2B 7S 3
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& 123 - Rational TestManager - [Test Log - example]
Efl Fil= Edit W“ew Reports Tools ‘Window Help - 0 X
2=l | Suite:

Event Type
ilas | =

Computer Start

Euild 1 Fuild: — ; I
Euild & |Build E1 Application Start FPass 200T-6-15
Fuild B ¥erification Point (Ob. .. Pass 200T-6-149
Fuild B i—Og Holderg Verification Peint (Ob. .. Pass 2007-6-15
= . Build Bl Application Start Pass 200T-6-149
G 11& 311 Tecredoms Yerification Peint (0b... [NNESENNNN >007T-2-19
BRSPS Verification Feint (k... Fass 2007-6-15
| hpplication Start Paz= 2007-6-15
Start Date/Time: Log Meszage [(Databaze ... 2007-6-15
|2007-8-18 17:05:40 Script End (example) 2007-6-15
Computer End 200T-8-15

End Date/Time:
|2EIDT—5—18 17:07:06

1 | >
% m Test Case Results Details
J|Ready acmin Currertly Selected Filter:

|:| File Edit Wiew Actions Query Window Help - 8 x
‘u_ll| | ‘| | @, Bun Query m ﬂ @ Hew Defect | W %ﬂ _I_n
x| Headline
-1-£5) Workspace: Queries, Charts, Re| = 1 =
+ g EELT-DHSI QL.IEI’iES thiE @E’J’thﬂ"ﬂ
- ublic Queries CADVE R
+-[[]] AutoIPECETE O B e e ST
+-[[]] AutoPDMIEEE : e o
FTiERAE R PIFERNES
=] a F'-LItEIF'DﬁH: Euxahmﬁ
{EH Restricted Query i
; TR
T fEsEmr .
@ AT = HE-=mREFESITF
0 st i
I 3ER ittt Bl
T S EEEEEJ'J%‘I‘EE#
A e SRR IR
T B3I RIS ATEIAT , M NG ER TR ENRE £5 , HEEA <]
+ (7] AutoPFAER DB R - et F T s
+ [ AukoPHIETH: CADZO07-T-HEAEHIHhER
+ [ AutaPSagiid
+-[_]] PrintReportFormats
-5 EhPEEE
EEE R I A ‘ i >
@E_ﬁﬁﬂﬂﬂﬁ_ * PhResult set 4 Query editor A Display editor [
] i »
[
Fecord: 1 Court: 15

6. il TestManager. LogView A1 ClearQuest ) report K 43 A7 il
51 PRI 5575 3] 19



U

I o www.51testing.com

il 4 R

I L-_Ei scriptsummaryRpt.doc - Microsoft Word
T E #RIEE) MBI #HA D 80 TRO FEQ BOR W) #EBNM S04 Adobe FDFIE)

DeE el 2R - 08 R > F -0 - B I

T &

"5 24 & 3 W0 2 M % & 20 22 2 2 o2 3 32 M 3B 3 40 42 AF
k _
H
Script Sununary Report - 123 «

H
H
Name+ Types Descriptions +
TEE o GUI - ° \
example ¢ I+ £ +
Temporary 3cript G+ + +
H

1 171 fig: z.oE¥ 17 1A

X T Sample WM H

A0 4 Sample ok A 4 A Rational 75 1 3 46 I3 (¥ B
', i% Sample j& Rational H 5 [ § ------------- Classic Online, &
Bid VB FF KM

Classic Online & R ¥FH P i@ ik Online B H 5 FAT W 47 & Sk ¥
WA A5 &, 24 Classic Online 5¢ i, XA & D) Bc &, &% H 3h ik
Pt 25 B2 — AN AT W A B0 R AT I8 58 s fE ) .

R B B Rational HKJ{# H
WA o & ------ £ XWX 75 3K, 1F | Rational Requisitepro
ol B0 B A B TestManager

See Example 1

s K- s, B UF A 4 %5 | Rational Robot
[N See Example 2. 3. 7

ST AR 5575 1 20
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AR AT === [l 800 3K A A

Rational Robot

See Example 4

MK 4 2R - K A N2 B MK 45 | Rational LogViewer A

xR Comparators
See Example 5

N [R7 N2 1 75 X T — 1z 17 3 L | Rational TestManager F

i ok A A WK 7 5 R RER B IR | ClearQuest

AN See Example 6

TF 46 A 1 7 2%

® ‘2 34% Rational Robot

@® %% Classics Online sample application

® %4 Sampl [ Rational 7% H

® & BEABY B BT S ESHEAT T Ak

% %% Rational Robot:

‘% %% Rational Robot 1 4 2 F 5y

Rational Robot package % %% Rational TeamTest
Rational Robot

Rational TeamTest package % %% Rational TeamTest

Rational Robot

Rational Suite TestStudio package

Rational Suite % 3% 5| &

Sample I HFE 7 1) 2234

1. B [JF 4 ]1>[FE 7 1> Rational Software>Rational Test=>Setup

Rational Test Sample.
2. Wk
3. & Next,

Classics Online

SR J5 Finsh

GATE G, XA Sample 4 i HUTE [JF 45 1> [#£ /7 1> Rational Test

Samples.

51 MR R Hh 2R 7N B

21




U
2o st M www.51testing.com

Sample ¥l B 7= 1 & 32
1. ZEH[JF 41> [F F]> Rational Software>Rational Administrator

' * _ Rational Administrator

File Edit Wiew Tools Help
e L L RN K
—- & Rational Administratar Marne | Lacation | Path | ClearQuest
- @ Projects 123 E:laaal E:laaall...
123 AULOPSA DAEEr. Dl
AUtOPSA PDMS CoiilidEe., ool
POMS
4 | I | 3
For Help, press F1

2. 1&F# File>New Project K H 4, Kot — /X ihME, & EK
B NAH OGN .

' New Project - General

Pleaze specify the mame of the mew project, an empty directory
in which to ecreate it and whether or mot the project 1= UCM
enabled.

Eroject name:

|Examp1e

Project location:

|II : \mlliﬂﬁﬁﬂxmplﬂ Browse. ..

-

ST AR 5575 1 22
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30 My “h 7 i, BENWEARBHEHEROLSKED, X
T AL s, RS S BRAE, Ra st B s E o

' Configure Project

Beguirements Aszets

Azsociated RequizitePro Project:

Create. .. | Select. .. |
Test Assets
#zzociated Test Datastore:
| Create. .. | Select. .. |
Change Requests
Azsociated Clearfuest Database:
| Create. .. | Select. .. |

Models=
Azzociated Roze Models:

|
e |

0K Close |  Help |

4. fEARDH A, Ay BEAE 0 OC1E R 77 oK 1 IR B, P A1) & RequisitePro
i FH ) B e e, 7 vk i 5 — A Create 1% 4L, ¥ @~ K Br
N, 1% # Traditional Template (A% 48 #5 B )

ST AR 5575 1 23



—

U
L

' Create Project

Rational®
Requ:mtePro

www.51testing.com

[

4
i
0l

Composite
Template

1
10
10l

BElanle

Hew |
&

Malke Hew
Template

Traditional
Template

Use—Casze
Template

This template is best suited for those organizations that are most accustomed ko
a kraditional declarative requirements approach.

Document types included; Vision Document, Glossary, Software Requirements
Specification, Feguirements Management Plan, and Stakeholder Request
Dacurnent.

-

[ Detailsye

)4 Cancel |

Help

5. fffw oK 04 S AL B

' Rational RequisitePro Project Properties

Froject Properties

Hame: |Exmple%$’t

Directory: |]]:\iﬂl]iﬂﬁﬂﬂExmpleﬂExmple%ﬂ

Browse. ..

Tatabaze: |MS Y

=~

legeription:

AT eI RR

0K Cancel | Help |

M 4 2P E A Create

51 MR R Hh 2R 7N B
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' Create Test Datastore (Page 1 of 4)

Choosze the type of test datastore

(" Swvbaze SQL Anywhere

Choosze Sybase SOL Angwhere whenewver more than one user accesses the test datastore at a
time or 1f the best possible performance 1z a priority.

Hote: A Sybasze SQL Anywhere serwver must be running in order to create a Sybase SOL
Anzwhere test datastore.

Choose Microsoft Access if only one user accesszes the test datastore at a time

' Microsoft Access Settings (Page 2 of 4)

Hew test datastore path

Y Fxample'iTestlatastore Browse. ..

< _E—#(E) |'F—**J3 () >| HiH

ST AR 5575 1 2
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' Initalize New Test Datastore from existing assets (Page 3 of 4)

Initialization Options

[ Initialize Assets from the following test datastore:!

[ Inmitialize Test Users and Groups from the Rational project:

| 2

< _E—#(E) |'F—**J3 () >| HiH

' Create Test Datastore Summary (Page 4 of 4)

Create a new Test Datastore with the

Location = I Wi e R WExampleiTestDatastore
Type = Microsoft Access
Initialize Asszets from

Tnitialize Users and Groups from

miE |
7. MAERAKEEL TOHHTGTRMAHMW AN TEME, &
Rational Administrator [ 0] LLE 3 Z I H 115 &

H /o o
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++ Rational Administrator

File Edit View Tools Help
. ; ity
L L e Hm
—- B Rational Administrator Property | value
- @ Projects Marne Example
123 Location D i BT Ecannple,
ALEOPSA Path o il & Example’ Exanmpl
LM Clearuest Database Mame
e Eoample Db Connection Mame
-armpe Yersioning Requirements Mo
Versioning Test Assets Mo
TestDataSkarePath D i B Exanmple! TestDa
RequisitePra Project Path O il B TR E xample Exampl
IIZMEnable Mo
Version <nknown =
] T »
For Help, press F1

EXAMPLE 1

WK - R

i N T SRR A%

N IE A RequisitePro ¢ gl a7 AR 7 SR MUK, H AR B p .

1. 3 3) Rational RequisitePro, 7 JI “Example” i I

2. % ¥ File>New>Package X a4, @& — M T GUI Wl
BRI A% 1

Package Properties

Hame: |GLII =
Deseription: |FigRA PR EHFERER. | -
-
Parent
Package: |Example (Root) Browse. ..
0K | Cancel | Help |

3. fF GUI #FHkK FAIEE — 4 View, @& N M GUI 7K

ST AR 5575 1 27



e

U
N W

www.51testing.com

' \View Properties

Hame: |.EFf BRIGIESE
IEFRBS EmiiE

Desecription:

F
-
Fackage: |GUI e Browsea. ..

View Type: |Attribute Matrix ﬂ [ Priwate

Eow

Bequirement Tape: | Huery. ..

fuathor: 1y

Date: Z00T-6-Z0 Time: [10:11

0K | Cancel | Help |

4. £ GUI 753K T @) & 2 — A Wk 75 K 0%

Requirement Properties: pending

General l Bewision ]Attrihutes liracea'bilityl Higrarchy l]:li_scussi-:-ns

Type: |SR: Software Requirement ﬂ

Hame: [FUT-001 : Classic loginfP

Text: 1257 iH TR P -
-

Package: |GL|I = Browse. ..

Location: |Datahbaze

1] 4 Cancel Help
5. 408 F& g Ik i 7 220 ) T R A e i N B R, & e LA
B B PR

51 MR R 2B 7S 3 28
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EFlle Edit Wew Reguirement Traceability Tools Window Help - a8 x

“H]_] QK e =% B2 EH 08¢

—| 4. Example J BRequirements: Friority Type |
+ [:l Cowverage Analysis
+ [ Features and Vision SR1: GUI-001: Classic loginipm Medium
+ [ Glossary EZRERATHPHER
2455 GUT
@ﬁﬁﬁa{lﬁ;ﬂﬁi* SE?: GUI-002: Classie OnlineSEm Medium
o
[C7 SRL: GUI-00L : Classic logindPil EREATRPHEAT
[[7 sRz: GUI-002: Classic Orlinedf. . BiE i
Eﬂ SR3: GUI-003 2 Make An OrderFE ‘513: GUI-003 - la/]ie An !]rl\ler Medium
[C7] SR4: GUT-004% View Exising Orde.. RREATH PR~ TR
Inpact Anal
2 Inpac Lt SB4: GUI-004: ¥iew Exizing OrderSifil Mediun
# [ Software Requirements ERERATHPEEEFERTER

+.[7] Stakehelder Requests
@ Requirements Management Flan

<Click hers to create a requirement? Medium

iZ5 A TR PEIEFESITIBEER

»

* i
SR4: GUI-004 @ View Exiszing OrderSRME a
1z EATRASE E?—?ZEE%IZTE”EIE E.

Kequirement SE4 modified 4 requirements

a1 2 K 1 H

X UK A H Rational TestManager T H k& ML, HAADEM .
1. J43) Rational TestManager, Jf§] H “ Example” & Jil.
2. A 223 AR X B AR & AN B B ol BB A A A TR I A A B B

#& Example - Rational TestManager - [Test Plan - ZHc#lit 1]
E]] Fil= Edit W“ew Reports Tools ‘Window Help - 0 X

S v@dE Hd ¥ BB

=l =y Rhsitg
=1-[_] Test Flans #-[] Default
b R
= [:] Iterations
o BRI
o BRI
o ORI
& e
i Bl e
i SRR Ex
o RHNGEE

e
3
Ry
2
B3
B

J|Ready acmin

30 @ AWk, e A Ak R gl o R, JF B AE

51 PIRR T H A5 7 1) 2
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Iterations-Configurations UUH B B € A7 Bl “ R G WK B B 7, I

REE E LA Standard-WinXP

' New Test Plan Kl

External Documents ] Custom ] Statistics ]
General l Tterations — Configurations
Hame:
EE R TER Bl
Description:
A Four # i, A
-

Owner:
admin _:J

TR mE | Em |

' New Test Plan Kl

External Documents ] Custom ] Statisties ]
General Iterations — Configurations

Tterations:

2l B Select. ..
Properties..

Configurations:

Standard - Windews XP

Froperties. .

mE | mw | ®mE |

4. B “ N CAr W R B H sk, IR H S Al e
ET W AE B R IE s e 1 H sk

ST AR 5575 1 30
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" %8 Example - Rational TestManager - [Test Plan - Z&caistit£i]

E]] Fil= Edit W“ew Reports Tools ‘Window Help - 0 X
B8 e EE = E-) E . 27l PER DB
SEI EN T ]
] [:l Test Flans + D HREThaR
b R +- iTM—7#EHe
+ [:] Tterations = [:l HEEITIEER
+-25 Eryn gl e e
N EEE T
J|Ready acmin
5. AE “BUEIT M AE B O A

7R H SRR AR
3

External Documents ] Implementation ] Cusztom ] Statistics ]
General Tterations - Configurations ]

New Test Case *

Test Inputs ]
Hame:

IT-TO-003-001

Deziznm. ..

Description:

Owner:

admin

fiRE HiH #ERN

ST AR 5575 1 3
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6. IEFE Test Inputs UL, o Add 30, #0W8 H H1 F0 xF [ 1

W RO v B 5 K

e S

2 axa_]ple = __B,s_.tiun_a.]_;’_l, Iegtlanal_v?——_ﬁfva-—w-.";-_.m -
m Hew Test Case = [§|
i i
“ a @ ‘@] @ |:=;E ﬁ | ‘XJ External Documents Implementation Custom I Statistics I |
A _i___j = General I Tterations — Configurations Test Inputs
=-ixt 1d
!_'__'!.a Test Flans hssociated Test Inputs:
Bl RN MSES. 1 IT-TD-003-001 & 3iEiT (s BAYIE Rt Add. ..
[= ] Iterations
R REREE #f Test Input Selection

i ERIRTE
R RREAR R

BBl fational RequisiteFro
[

@ ﬁﬁ_—n:lmfi n [ {:’.\ example

g ;ggﬂgg? ~[J Coveraze Analysis
i : 07 Feat d Vici
@ FImERT Checked inputs = G]e.:s:l::- SRR

=0 eUIFm®

[0d] SR1 GUI-001 : Classic LogindR@E

[0d] SR2 GUI-002: Classic OnlinefRHE

=-[C] SE3 GUI-003 : Make An Order SR

- -[od SE3. 1 IT-TD-003-001 @ BTECTTENE
BRIERE

".[C9] SR4 GUI-004 : ¥iew Exising OrderBH
D Impact Analysis
[:I Software Requirements
D Stakeholder Requests
- Rational Rose
Microsoft Excel

Det Filter (35 Cancel

7. % £ General TUIH, B i Design #% 41, # (Exampe J H F& 4t il
WK H B & F) H IT-TD-003-001 H 1 (#1047 25 B g A 2] &% i1
N E LG RIEE 25 — MNP EN & TP

ST AR 5575 1 32
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Iik

|28 eede v

=] General l Iterationz — Configurations I Tezt Inputs

External Dlocuments I Implementation I Custom I Statistics

'—_'a Test Flanz

Irpe i Hote I Description Insert ‘
1 * 1. fTHClazsic &, FTrent Culpito@hh
| | Remove i
i » &y ﬁ@]lﬂzart
] & 3. EE FFFEF symphony Foo 34 Edit Hate.. !
B o | 4. 3 sz here to Order
- I3 r 5. WEWEHEMake in Ordar B
2 & | [ FlEmIghe cE I Import j
7 r 7. HigfOeder—>Viewing Exising Order Staus, B&COMEHEE
FEZET N 114 I
25 Symphony Hoa 3¢
Cancel |
¥ Enter key moves focusz to the next row _“

8. ¥ uyiH ML, # (Exampe Ui H R MWK H B 1Y A
H 1 ¥ 11 % A 2| TestManager

g:B example — Rational TestManager — [Test Plan — Fic@oliihill |- ”EJ'X|
%Eile Edit V¥iew BReports Tools Window Help - O X

—

D8 BB E S

Ha@ s 2R |gs
=l = by Rt

2Zey |PHBEES

[=}-=5 Test Plans i [0 =REThie

B RSO - T~ e E

B Tterations =0 MEEITEEES
..... o =R = | IT-TD-003-001
..... @ fIE R Er “oyhke Standard - Windews XF
..... @ AR R B E| d IT-TD-003-002
..... @ s=TOp EE “ogly Standard - Windews XFP
..... BTl e =l | IT-TI-003-003
..... @ 1 M B B ke Btandard - Windows XF

..... ¥ RSRT [ HEELTIEE B RVIE TRt

=P EENENE TS

Ready admin v

EXAMPLE 2

ST AR 5575 1 3
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X B A
1o Y s B A TF o6 1 i i, /MM A & 1, BR T TestManagers
2. fE TestManager [f] T. B # 1 fi 17 Rational Robot 3% 4l , JF 4/ Robot.

Fa

3. /M TestManager

4. M Robot & I, i+ File>Record GUI

7 0Open Script

Neme:  [ERRIE] A,
AT
Query: [Standard
Hame Seript Type Description
I~ .
AT E 4
e X
1 1 1
)4 | Cancel | Froperties. . | Help | $$ OK

GUI Record T A £ H L7 Robot M &£ F A/, R LA ¥ A & 1 75
KR AE N AN A 1 P A

GUL Eacord
n m & 34 . ) _
& i Display GUI Insert Toolbar #% 41 3K ¥ % GUI

N T AR

] a1 B O B s o 50 ver 5 4D B Bo OF B BY 20 @ &2

5. fidi Start Application %4 EI
HE ERIFE N R 280, kR A T 5 2% 50 8 5Ok I iR
— NN AR, RS R T 2 1 2R 2 AR 8] TS0 AR D A B

ST AR 5575 1 34
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6. riii Browse, #AJ51E B BILM Classics Online sample N H 2 /7
AT

C:\Promgram Files\Rational\Rational Test\Sample

Applications\Classic Online\ClassicsA.exe

7. il Open, %R )5 & i OK

8. H Trent Culpito /£ 4 & Ffi, s OK, 4T JF Classics Online

9. sl 5 AR )+, H 2R FE ) Mozart

Wik Mozart, WI%iT
W) H =%

Symphory in C, Ho. T
Comcerto in I for Piano

Abun | Datails |

Hozart

Symphony Ho. 34

£+ Syphony No.34
W. A, Mozart

Svinphony Na, 34

lData Betrieved

) B B 3% I B A

2z
Ele

1. £ GUI Record T HF~ 1 sfifi Open Robot Window #Z 1 = .
2. e KA AR WA s ) A

ST AR 5575 1 33



oy i R [Ty 7 -
I o www.51testing.com
% exanple - Rational Robot - [H4-7]%J s]

Eile Edit View Record Debuz Inzert Tools Hindew Help -gx
& 0 o e &
— I RE R ) T 46
Ef Verification Po
—— Sub Hain
GUL Becord Din Result As Integer
I mF i
'Initially Recorded: 2607-6-24% 18:18:23
‘Script Name: E-T0H
StartApplication """E:\Program Files\Rational\Rational Test\Sample Applicatic
% ki

Window SetContext, "Name=frmExistinglogint,—
PushButton Click, "Name=cmd0K"

Window SetContext, "Name=frmhain™, "
Treeliew Db1E1ick, “Name=tretain;\;ItenText=Hozart™, ™" _———— | % H %E’(}@ﬂ:
TreeUiew Db1Click, "Name=treHain;\;ItemText=Hozart->Symphony Ho. 34", "

TreelUiew Db1Click, “Name=treHain;y;ItemText=Hozart->Symphony in C, Ho. ¥1: Ju
Treeliew DbIClick, “Name=treHain;y;ItenText=Hozart-*Loncerto in D For Piano",
Treeliew Click, "Name=treMain;\;ItemText=Hozart->Symphon

End Sub

WAL VB

< 214 ¥ N .

— LTI R

2 tremain, AMYAX
e A bR

Build /| Consale |
Recording Suzpended Recording 00018 001 admin

;
O

3. R EBMA TR TR A K473 & /D Robot &
AT
Bk s 1. Al SRR A R )

P
&) il
1. R »E, S Display GUI Insert . H £~ #% 1
2. WP H N E, &/ TestManager & H
ol
DT

3. Riii GUI Insert T. B #4734 ) Object Data 4% {1l
4. 545 OK, % Object Data 1F N 5 — A5 AF 25 1 & 7

51 MR R 2B 7S 3 36
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Yerification Point Name

2IX

Hame:

Wait state

[ Apply wait state to werification point

Expected result

(* Fass

Rl OK

(" Fail

S5elect Object

&

Draz the Object Finder tool ower an object, and then
releaze the left mouse button to select the object. Tao
zelect from a list of all objects on the Desktop, click
Browse.

Object Finder

Selacted

RecMethod

[ Automatically close dialog box after object selection

0K | Cancel | Help |

5.

Select Object

#iili Object Finder K
Y24l Classics Online &
H, R TR
il

FiAE SHIFT HK iU
Robot T i 45
%5 (Name=)

4 Object Finder L. H % 2N H B P (1 10035 /1) 4 5 A1 H =% 71 &

HE s 8K 5 R T80 b 4% 3

3

Drag the Object Finder tool ower an object, and then
releaze the left mouse button to select the object
select from a list of all objects on the Desktop,
Browse.

Ta

cliclk

Object Finder

il

Selacted
¥izual Ba=ic

[ Automatically close dialog box after object selection

I BT BN % A2
Tree View (OCX)
Visual Basic, U15EAS

IR A 25 10

—

6.

V& 4] Object Data Verification Point X 1 HE H %

51 MR R 2B 7S 3

i OK
2| R
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W 4 e 4l 2k 21K A 7%

7 Object Data Werification Point

Selected object: Trea¥iew (OCX), Hame=treMain
Data test: Contents
Yerification method

Brandenburg Concertos Nos. 1 & 3
¥iolin Concertos
Beethowven

Symphony No. 7

Tdentification method W Trenoze men

Columns: By Locatio [ Mowe column titles to 2xad
Rows: By Location »

Fumber of columns and rows
A1l 1tems

Becapture | Help

Robot /i3RI
1R B 28 42 4l 1 %
P, RIAE P SR
fETT

PRAT LAk B AN
X LEILE, Robot
SR ) 4 1Y
JLH

7. s OK, w58 T — A % Uk w10 il 3R
Bk s 20 Al 3R AL JE

1. f£ GUI Record T H# " i Open Robot Window % $ll

i ii Object Properties 1% 41l
B sz A sh iy 4 Kk A, s OK

S~ W

5. Wi Wk BN % & PushButton VisualBasic,

51 MR R Hh 2R 7N B

\ W A TG

ESIREZE 30
T

% 3 Object Finder . H £, ¥E press here to order % #l Ab B ik
st OK

38
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I Object FProperties Yerification Point

Selected

U
% W K o

Properties:

FushButton, Hame=cmdlrder

www.51testing.com

- B

*|| Edit List |

Robot JIT il 3k
1A $ 4
P

Hame Value
1 - 3D 1 —

BackColor [ IRGE (255, 255, 255) [

BaclColor. Link Menu

Cancel False

Caption preszs here to order

CauzeszWalidation |True

Claz=zHame CommandButton

Default Fal=e

Iraglecon Eitmap

Iragflode 0 - Mamuaal

Enabled True

Focuz Falze =
[ Show werification method

0K | Cancel Recapture Help

6.

1. B e mthi<<
oA m
Selected #% %
Available #

IR
% HEE
W, Text, 1%
FE Text

7.

%Ak L3

I.
2.

4.

A i Edit List

Edit Property List:

Available:

Style

Tagz
Text

Yalue

[T Save

Vizible

NEj cture. Width ~
EigktToleft 3

TabIndex
TabStop

ToolTipText

/ Top

UseMaskCaolor
UseMasklolor. Link

[ Apply to all like objects

as default

ThunderCommandButton

Selected:

&

|| % 3 ik

L) Text
#| Selected

Al OK

i Lancel i

s OK 58 T 55 — /> % ik s 1 38 A

W% Susan [

AR Susan D&MW T — AP

i Close

51 MR R Hh 2R 7N B

7 s PR ORE 428 o) Al 3k 2 9
PL—AN 8 0 4 % B File>Login As New User
1% # Susan Flontly, #iii OK

{5 &, % $ Order> View Existing Order Status,

39
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5. % ¥ Mozart ) Symphony No.34, #iili press here to order

Nake An Order

Ttem: Bach - Brandenburg Sub-Total: $ 16.99
Concertos Hos. 1 _3

SHH: $ 200
Total: 1899
Quantity: 1 ° ¥
—FPayment Information
Card Fumber (include the spaces): || —_———1 | 12345

Card I‘.l"isa LI Expiration I
™ . TMata- —_—

—Your Information

12/99

Hame ISusa.n Flontly

Street |15u Central Expy

City, S;ate |1nr, T 12701

b

Telephone |21u—33'r—1uuz

154l Place Order, 2R )5
mili OK, 8 T i1

Flace Order Canicel

6. £ P& Order> View Existing Order Status, & 3 — A8 11 W 5

PIATA ]

# View Exiztaing Orders

Orders for Susan Flontly

ORDERTD STATUS COMPOSER COMPOSITION | o]
5 Order Initiatec Haydn Symphonies Hoz. 99 & 101
21i0rder Imitiatec Bach Brandenburg Concertos Hos.

Cancel Selected I:Irderl Close |

7. PRERZAIEHEFT T, R 4R — AN UE AR N
8. X HIMAL MWL A, Mii OK
9. # 3 Object Finder F| #% F &b, 2R J5 B B A5

ST AR 5575 1 40



U
N W

www.51testing.com

10. fiff € BT & £ 19 XF % 4 Generic

(OCX) Visual Basic,

&l OK

Object Data Tests

Robot ¥ ¥ 3K

Selected object: / Fﬁﬁi‘%?#‘ﬁ‘]

Generic (ICX), Hame=FlexigridOrders EVgiT

Data test:

:

Description:

811 Data capture of the

MSFlexGrid
sl OK ki
L ST A 3 A

0K ancel Becapture | Help | ¥
11. 5 OK, 58 B T %3k & f) 4l A

Bk RU 4 il R A A ] R A e v
1. #fi € View Existing Orders & H ) #] JF

i

2. FFUR—ANKUE T %8 Mk ==
3. XA mA MRS, M OK
4. pith Browse 1% 4l , Robot Hf & 2| Py A 5L 11 b w] #8 A1 A 7] #1 6F %
M Object List
—Tindow Class=tooltips_class3Z; Level=2Z2 -
XXI:J-:I T’XT | 4% \ —Tindow Caption=CicerolINndFrame;Level=2 [ |
frmExisting, \+\—'I'indu'l' Claz==#32TT0; Level=12
-~ — Yindow Hame=frmExisting ;
TR IES |- Label Hanz=1b1Name V Show hidden
REFH View - Label Hame=Label? [ Inwert ohijee
Existing I—GenericH e=datafxi=zting
. |—l"u5]:|]]uttn Hame=cmdCancelOr der @
Orders ﬁlﬁ |—Generic (OCX) Hame=Flexigridlr
*EE(JX%% L PoshButton Hame=emdllose
Tindow Class=tooltips_class32; [éwel=23
- Tindow Claz==tooltips_eclass3, Lewvel=24

- Tindow Claz==
I Tindow Hame=1;
—Tindow Hame=1;
—Tindow Hame=1;
|—I.abe1 HameqlbAConfirmation

51 iﬂﬂiﬁ%i@%%ﬁﬁ/
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J&€ 71 Robot JIT KajE K] 1 FEXT % 4 Generic .
H 3R N
A i % Name=dataExisiting mg %ﬁ%}‘gﬁf@x
AN T R E A 42 ) B AT -
A INAE/ R

5. AEEUE RN G R XS 5 HE B R LU B Visible B {E 4 False, X3
WA % B 98 5 s AN TR, {H 2 A0 2 & g Robot X 5k i oA
JIT 41l 3K

6. mith OK 58 B 7 iR

7. mili Close

8. K H] Classic Online

ril

9. riiF Stop Recording #% il
8P g i) A A

’ example — Rational Robot - [B--71W3]

Eile Edit V¥iew BRecord Debug Inzert Tools Yindow Help =5 I
S BLUSE ek 3 FIELECEME o N @ || D B R
XX I:J_:f - @‘i’erification Fa -
B Dbject Data ‘Initially Recorded: 2887-6-24 21:36:54
. - - A .
/]\ \ @Dbject Prope Script H?me'_$ |II:L;—;|:R|"¢J A A
B Object Data? StartApplication E:\Program Files\RationalyRatjonal Test\§
% uF \\\\jf?
RbaScEpisons Window SetContext, "Name=frmExistinglLogin", **
= PushButton Glick, “Mame=cnd0OK™
EL %% Window SetContext, "Name=frmMain', " WN
?U ﬁﬁ TreeView DblCGlick, "Name=treMain;\;ItemText=Hozarf" ‘it
TreeView Click, "Name=treHain;\;ItemText=HMozart->Yyn 2 Mo .
iEL i% TreeUiew Click, "Hame=treHain;\;ItemText=Hozart->Yyn Hiu in
TreeView Click, "Hame=treMain;\;ItemText=Mozart->Qor in
Result = TreeUiewUF (CompareData, "Hame=treMain™, |"| ct
Result = PushButtonUP (CombareProperties. “‘Mame=cpdOrder®. “UY
< > £ ¥
x|
i
| [\Iiluildig"(\Console;'r
Recording Ended 00056 001 |admin

DA R i B

Windows SetContext {E & NMAT 81 M IF 46, FHid & I 45 BL()
BEAS U6 UE RUPE O SR — AT IR JT 4R 8 Restult=
AR A A A

ST AR 5575 1 42
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® Sub Main------------ & WY A 1 T 4

® Dim Result as Integer--------- 7O UE R Result 1E 8 — A48
W, XA Rseult & @ XK & ERF K

@ 'Initially Recorded: ---------- B 2l s Bl s 1 AR 1 H 3 R
[i1]

@ 'Script Name: ------------oon- & AR 44

® Window SetContext---------- £ AT B kR E A

® Window SetTestContext-------- € X ANk 5P AN 1)

® Result= & AP IC k0 — DK AR . XAAE SR T X%

24 A i 4 AR 0 7 VR I
® Name = & X T Pr A 0l % 4
@® PushButton Click----F& W] — AT )7 (047 8 iy &
B RIAEC LD T — A A R DY AN 55 I AR N
® 7E B H s H s W
® I E I
® I HE N B s A s W
@ [ E s R I EXAMPLE 3
FA A B [B]

1. #f%E Robot [T JT

>

2. #i i File>Playback
3. EEE R “, sl OK

Specify Log Information

Ml H, A

Build: // Build A i OK
Bulid & RA|
Log Folder:
Build A M IXH, A
Loz Build A fiti OK
|$¢J@

0K ! Cancel | 'H'n'|p ){—ifﬁ‘ OK

ST AR 5575 1 43
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PRF 2 B 45 R TE LogViewer

¢B eraaple — Rational TestNManager — [Test Log — BT

@ File Edit W¥iew EReports Tools Yindow Help - |8 x
Sl e U BE s | FESEEYR
i Suite: Event Type
{3 Test Flans | - Computer Start
+ (0 Tterstions Build: SRS ipt Stk (871 14)
Build A Application Start
Verification Point (Object. .. 2007T-6-24
Log Folder: Verification Point (Object. .. 2007-6-24
Build & Verification Point (Object... 2007-6-24
Tteration: Verification Foint (Object. .. 2007T-6-24
: Seript End (BR--{TTH) Z007-B-24
Computer End 2007-6-24
Start Date/Time:
ZO07-6-24 22:17:42
End Date/Time:
Z007-B-24 22:17:56
1 | »
] % | E.. @ R ‘ Test Case Results Details
Ready admin Currently Selected Filter:

4. i File>Exit %] LogViewer, [0]%] RobotEXAMPLE 4

T — A Fr B RR A A PFAS B R 4 R

OB RAT KR — N XA IRAK A, Classics A 1 Classics B -
PR T R A [E

Classics A

51 PRI N 44
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# Classics Online

File 0Order Help

Bach

Brandenburg Concertos Hos, 1 & 3
¥iolin Concertos
Eeethowen

Haydn
Mozart

Album ] Details

Bach

Brandenburg Concertoz Hos. 1 _3

J. S. Bach

Brandenburg Concerfos Nos. 1e>3

press here to order

Data Retriewed

Classics B

L = 2
# Classics Online

File Order Help

1. Choose an Album

=~ Bach
{ BT andenburz Concertos Hos. 1
i e ¥iolin Concertos
+- Beethoven
+i- Haydn
+l Mozart
+ - Sehubert
b ?

3. Place Order Order Tt

Aocess mode

2. S5ee AMbuom Details

Al bum ] Details

Each

Brandenburg Concertoz Hos.

1

J. S. Bach

3

51 MR R Hh 2R 7N B
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L —/NF I Build R [B R B A

1. #iii File>Open Script

2. EFE BT, i OK

3. FE A R A I B 42 20 Classics B.exe
4. riii File>Save

5. JF#5 playback

6. EF “HANITIY”, A OK
7. Robot R g ¥ I A IF [0] 5 — 3% 5 1) 47 3 A Ik s
7 LogViewer H & & I ik &5 R

¢B eraaple — Rational TestNManager — [Test Log — BT

@ File Edit W¥iew EReports Tools Yindow Help - |8 x
Sl e U BE s | FESEEYR
i Suite: Event Type
{3 Test Flans | - Computer Start oo i
+-_] Tteratioms Tuild: B Coript Start (EE-TUTIR)
Build B Application Start
Verification Point (Object. ..
Log Folder: Verification Point (Object. .. 2007-6-24
Build & Verification Point (Object... 2007-6-24
Tteration: Verification Foint (Object. .. 2007T-6-24
: Seript End (BR--{TTH) Z007-B-24
Computer End 2007-6-24
Start Date/Time:
Z007-6-24 22:35:05
End Date/Time:
Z007-B-24 22:35:23
1 | »
] % | E.. @ R ‘ Test Case Results Details
Ready admin Currently Selected Filter:

R ¥ & 2B A WA T /& Fail.

7 Comparators 7 4> #7 ¥l ik 45 &

Comparators #& fit T PU B bb 4% 6F % -

Y T O —— S0 N S
CRRTE Y L — S0 X %0 T4 9 A R

SCAS R 3 o Uk

R S — RSN DL PN P

51 MR R Hh 2R 7N B
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K 4 56 R R

® [KJP - WS B S DX B R B IE SR R
Kl B

R WA “RM 7, KA baseline file i W % A0 % 1 H 45 A1 & TE
WRAE “RKMW”, #eH 4 actual file K % F 4 — baseline file,
i O X e R R, R R LA E a2 BT Build SRS, &
& T AN R R

@,Grid Comparator — H--1J#.0bject Data?
File Edit ¥Yiew Help

HE o M4 PN 888& @W

|Base|ine Lﬂmtual

ORDERID |STATUS |COMF‘E ORDERID |STATUS |CDMPGSEFI
1 Order Initiated Haydn 1 Order Initiated Haydn
2 |21 Order Initiated [iBEaM | 2 21 Order Initiated [ERCHN

< | W[l <] | s

@ Comparison failed: 3,2
@ Comparison failed: 4,2
@ Comparison failed: 6,2

Ready

DU R o IR

1. X il Verification Point ( Object Data) -Object Data, X | % 2] 4
ik s AE

ST AR 5575 1 47
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@,Grid Comparator — H-7i[®. 0bject Data ﬁ|rﬁ|§|
File Edit ¥iew Help
el & & N?
Baseline
1 2
ElGach |
_2 | Brandenburg Concertos Nos. 1 & 3
_3 | Yiolin Concertos
_ 4 |Beethoven
_h | Symphony No. ¥
_ b | Symphony No. 9
7 Symphony No. 5
_ 8§ [Haydn
_9 Symphonies Nos. 99 & 101
10 | Symphonies Nos. 94 & 98
11 Yiolin Concertos
_12 |Mozart
_13 | Symphony No. 34
14| Symphony in C, No. 41: Jupiter
15 Concerto in D for Piano
_16 [Schubert
7 | string Quartets Nos. 4 & 14
18 | Die schone Mullerin, Op. 25
19 Symphonies Nos. 5 8 9
Ready

2. & F File>Exit X M Comparator

5 P A I T B AIE R

U N R 7o

1. X i Verification Point ( Object Properties) -Object Properties

51 MR R 2B 7S 3 48
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54 Object Properties Comparator — H-i[®)_Object Properties ['. ||'|:||['5_(|
File Edit ¥Yiew Help

E B M M &8 8 @8

Properties:

Hame [EBazeline |15.ctual
Text [press here to order [Order It!

Differencas:

Object “PushButton, Hame=emdOrder”, Property “Text”™: Compariszon failed

2. miili File>Replace Baseline with Actual

3. siii Yes

4. N — KPR AN T, 5 UE Rk 23 B ok
5. % $ File>Exit |7 %] LogViewer

D B AT A A R

1. Verification Point ( Object Data2) -Object Data

ST AR 5575 1 49
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@,Grid Comparator — H--1J#.0bject Data? E|E|El
File Edit ¥Yiew Help

HE o M4 PN 888& @W

|Base|ine Lﬂ;ctual

ORDERID |STATUS |COMF‘E ORDERID |STATUS |CDMF‘GSEH
1 Order Initiated Haydn 1 Order Initiated Haydn
2 |21 Order Initiated [MiBEaM | 2 21 Order Initiated [EECRN

| | W[l 2] | b

@ Comparison failed: 3,2
@ Comparison failed: 4,2
@ Comparison failed: 6,2

2. & ¥ File>Exit A/ %] LogViewer
0 ok

N
VA=

RO& ;2 E 41 H LogViewer Ml Comparators K 4> #1 M build F
build ) 5 A4L, IR o K I 2 — A B AR 1 o5 AR ok i R R
L U/ A g AN <o)/ NE 2 S

® M TR E 1R I

@ URAEHAEN, TH4T baseline fileEXAMPLE 5

g # A B B B

%7 B ClearQuest K ¥EAT, 2w O, A £ #ik
EXAMPLE 6

B 3 4 B iR A

HI T A ] Crystal Report, T8 IN A% & 18 1] EXAMPLE 7

5 90 4 B A

ST AR 5575 1 >0



U

2o st M www.51testing.com

H -
D G R R AN TR 11 NG i1 O S S S I " S S 1 71 @ 311 N 0
T 0 A B BN B P
& -
MR F W CRANITI WAR, RN T AR A AT
() — A T2 Bl 3T W A5 A R iR OB T I AR

un BEAE 0] RO AR T, — AN B AT I B A N R, AR TR AT 0
W N EHE I A B AS [DRORE R M. Ol T A XA T A
IR Sl A o A /NS G VAN I e Rl NS LN 7T A S I E P
i BB X R AT

T EBOX A, R BN SR AR R AT A S H T A i
IR “ B AT A . AR AR AT A g N — A Sk S
1 R TRl A A
FHMFELTE XA
1. 7& Robot H' siili File>Record GUI
2. FWANZT: BRI A, i OK

1 2
2| |
3. i L HA#H: Display GUI Insert =—
4. & ity Start Application % #l -
5.  Type Hil browse I& # B A 19 4] 7 2 )7
C : \Program File\Rational\Rational Test\Sample

Application\Classic Online\ClassicA.exe

6.  &iifi Open, Jimii OK
7 PL Susan Flontly & [fi, 5 i OK
8. i Order-> View Existing Order Status

ST AR 5575 1 >
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# Yiew Exizsting Orders

Orders for Susan Flontly

ORDERTD |STATUS | COMEOSER | COMPOSITION |Q
5| 0rder Initiate: Haydn Symphonie=z Nosz. 99 & 101

O K P X U5 AR R4 1R
10. #iii Stop Recording
FLEXHA:

L. HE “EREA” 4TIF

7 ezample — Rational Robot — [EHH A =]

[Efl File Edit View Record Debug Insert Tools Window Help _8 x
— - = — =
s BPREE ooy sTEIGEe NS S &L HAD AW
[ Verification Fo YN
Sub Hain |

Dim Result As Integer

‘Initially Recorded: 2887-6-29 23:46:15

‘Script Mame: FFERIA
Startapplication " E:\Program Files\RationaliRational TestiSample Applicatic

Window SetContext, “Name=frmExistingLogin™, ™"

ComboBox Click, "Hame=1lstUserHame", "Coords=14%1,11"
ComboListBox Click, "ObjectIndex=1", "Text=Susan Flontly"
PushButton CGlick, "Name=cmdOK™

Window SetContext, "Hame=frmMain®, ="
HenuSelect "Order->View Existing Order Status..."

pI7|

H
. . M
Window SetContext, “Mame=frmExisting™, "*

Window CloseWin, ", "™

End Sub j][]

Lelx | [~
esl

U’T‘ 1
o

<7,

hul

Build #, Conzole

[ 00120 p04_adein

2. AWM ZERSE A Dim 5, BN
Dim RowCount As Variant

3. fE MenuSelect iy 2 Z J5, ¥ 1— 4 SQABasic iy % . X4~ 1fir &
M FlexigridOrders ¥ il o & ¥ 43 £ Rows @ PE. X2 &8 I
BT AT B REAAT B Tk AT M R AT ------- i

[Recording Ended

ST AR 5575 1 32



U

2o st M www.51testing.com
X L8 KT B AT B AR
Result = SQAGetProperty ( " \ ;
Name=frmExisting;\;Name=Flexigridorders " , " Rows " ,
RowCount)

5.

WE e RUEZ i A AR A I O —AT .

FEA &5 8 2 Hi i) End Sub, Ji A —A “If-Then-Else” & fJ .
WG, ERER — M5 E 4 LogViewer K ¥ b 5 4
¥y 1E 12k

If RowCount=2 Then

" Display message in LogViewer

SQALogMessage sqaPass, " Database 1is reset,ready for
playback ", " "

Else

SQALogMessage sqaFail, " Database is not reset" , " "
End If

Ry File>Save K 8 A7 9 0 1 85 0 A .

1l 3& — AN A -

I

B e 7 AR 19T T

ST AR 5575 1 >3
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7 example — Rational Robot — [EHEIFE =]

Eile Edit V¥iew Record Debug Insert Tools Windew Help

. @
Gl Wl

r BEHSE D E Y FHELEE RGN S H | S HRED

E Verification Fo 'SUD Hain

Dim Result As Integer
Dim RowCount AS Variant

'Initially Recorded: 2087-6-29 23:46:15
‘Script Hame:

Window SetContext, “Name=frmExistingLogin™, "

ComboBox Click, "Mame=1stUserHame', "Coords=14%1,11"
CombolListBox Click, "ObjectIndex=1", "Text=Susan Flontly"
PushButton Click, "Mame=cmdOK"

Window SetContext, "Mame=frmHMain', "
HenuSelect "Order->View Existing Order Status..."

Window SetContext, "Mame=frmExisting™, ™"
Window CloseWin, "¢, "

If RowCount=2 Then
‘Display message in LogUiewer

StartApplication """ E:\Program Files\Rational\Rational Test\Sample Applical

Result = SQAGetProperty ("\;Name=frmExisting;\;Hame=Flexigridorders","Rows’

&

Else

SO0ALogHessage sqaFail, “Database is not reset™,""

End If
£ PN >
£‘| [\, Build /, Consale /

00002 001 |admin

2. 1 # Dim Result As Integer 3| End Sub [ %
3. s Edit=>Copy
4. 46 61 33 B X . File>New—=>SQABasic File
5. miii Library Source File i OK

6.
7~

& iy Edit>Paste
5 P SCAF TS, 58 SC— AT ARl 1 3C AR R e 1R 44 7
Sub RunTestDatabase ()

51 MR R Hh 2R 7N B
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» ezample — Rational Robot — [HHEE +]

[ File Edit Yiew Record Debuz Imsert Tools Hindew Help - a8

ey BHEHS

VeE B FELEE G NS ¥ (@ HGD

[ Verification Po

4 b3l £

Sub RunTestDatabase ()

Dim Result As Integer
Dim RowCount AS Variant

‘Initially Recorded: 2007-6-29 23:46:15
'Script Hame: FFHTEIZ
Startapplication " E:\Program Files\RationaliyRational Test\Sample Applica

Window SetContext, “Mame=frmExistingLogin™, "

ComboBox Click, "Mame=lstUserMame™, "Coords=141,11"
ComboListBox Click, "ObjectIndex=1", "Text=Susan Flontly"
PushButton Click, "Hame=cmdOK"

Window SetContext, "Mame=frmMain™, "
HenuSelect "Order->VUiew Existing Order Status...”
Result = SQAGetProperty (“\;Name=frmExisting;\;Mame=Flexigridorders”, Rous

WUindow SetContext, "Mame=frmExisting", "
Window CloseWin, '*, "

If RowCount=2 Then

‘Display message in LogUiewer

SQALogHessage sqaPass, "Database is reset,ready for playback™,"
Else

SQALogHessage sqaFail, "'Database is not reset™,"™

ﬂll | » I\, Build /4 Console /

00002 023 |admin

8. A i File>Save

9, € X 4 % CheckDBLib, /i Save
10. /i File>Compile 3K 9a &5 FE T 1

i 2 3k 3CH -

1. 7t Robot # fi ii File>New—>SQABasicFile

2. A i Header File /& 7 OK
3. L E M — AT S E S, 2EXHES T A e~

RunTestDatabase:

Declare sub RunTestDatabase BasicLib

4. A i File>Save
5. % 4% & CheckDBHeader 1E & .sbh 3k X 4 #% X

6. At Save

7. A il File>Close

18 Jn 3k 3C A0 E

3C A B A A

1. & i File>Open Script

2. & AT, i OK

3. AWM WA Z E Sub Main, A
" $Include " CheckDBHeader.sbh " .

51 MR R 2B 7S 3

" CheckDBLib " ()
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4, (FAM L )R 2 F End Sub P in AN —47:

Call RunTestDatabase( )

5. SIS B R T AT A AR
\ &5

Ex

4

S A

IR ST

B4 n SQABasic iy & T B | A
g — A Sk 3

A gt — AN S

51 MR R Hh 2R 7N B
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VS2005 Team Suite B HE € B &R

B ar sl

W OE. ACEAY VSTS 41 K10 ook 6 @ shae B A s, 44
MRS A &R B BT R AT 58 s oo A, AR B Bk
399 3t % BL R B, AT A DR E PR R Y R A R AT T i

RBEW . VSTS: ool ohkBa, P

—. 37

R IR AR S Z W, AT D B BT LA W 8 O A 4 T Al
LASTvRY LR i TV 7 VAR E S o 7:/ 2 A A 1 AT [ ol (7 S O & (=

SR RE IS I R vl 7o TN PO TR N TETEa

AT E A AW 10 KRN A — At R A —
AL HEAT L R, AN AN B BT, gt Ul O I T 2SR
ZHUPRBEN, V&V BB AR 47 0 5 IATH & T XA . AR s B
B R B R, A8 R K B Be R I BUG J2 $6 BAS 5 fI% 2 5 i 250
(¥

Sltesting [ itds LA AN, WX MHE, EHKN KL
B A F R A A AT A&, B g AT A & R RN R
e . SO AR, FAEJLAE AT 2 m R T R R AR
IS 1% 48 R o0 WK R AT 25 B A2 45 O RN A

ZEONA, WU R P Bk a2 B AT O R A
GBI B AT T B R RO, R HL e B g IR R I T TR
NG S, FFRANGR T A IR MR FH A MRS E N DY E
LIVl 7 B A e 5T VA= e ol 7 W N AT 2

BOCI R M T ER M & XUnit, &4 C++Test. Insure++.

CompuwareDevParterner. Purify. PC-Lint. LogiScope. TestBed %

ST AR R H 5 1 37
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WRERMRE KPR T TR, JH4ET Java WA A DK T H:
Agitator. M4, EEHE G H = &WE T MH TCL %48, &£ TCL A
a7 | S AT (R 2 S I 7 A g A N 71l BV &

—. VSTS # il &/

Team i ) VS2005 HL 1 A% T 58 %/ Test Dyfig, HAKH : Unit
Test, WebTest fil LoadTest. iX — 4% £ [ U 5E AW o6 7 %A1 R &
il 21 00 903 3 R

S RENHAR 2 VSTS Bar R ITI B TR (Unit Test), &
KR I Ak gt o 5 T i AR RS 0 g% R, R Ho e B 3 0 g o oo il ik ER
5o, Be % Ak AN 1 g B 0 IR0 N O3 B AR R R AT B T TR

=L AR kR
TR FAT T T — S S ok B AR A S VSTS ool .
P00 K 1 R e, K R D R IR R AT
B W 2R S8 a7 A -> 4 00K eR o A >0 0 e SRR /K
J7iE) >3 AT ool

1. 0 & 4 & At

Pl R PR A RS, W AT N
AREASHHE BN CHRmWFEDY. “ BT R frHE K ] ik H
WO “A” ~ “F” F1 “0” ~ “9”

ST AR 5575 1 >8
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0 R EE R

PEERE (2007 TH TR |

| = ]
EEfI=#E : 099
B AHit#g: 570.24

Ziafits

n EE s, “NAR R T = s R R X REAL S BUE

2. HW R 8 B

F AT 2B e B TSR BRI, T RO B3 AE BRI R T

J& X FE I 1

//BAE
/// <summary>
/) IR XEAF, WEEH, HnE=1.8
/7 WMARXGEB. E, WEEFE, B E=1.2
/7 W RXFEC, D, WEEEE, Jhm AE=0.9
/7 IRYIE0T2, WIEHE K, BEm AUE=1.6
/7 W RYRETT9, WEE R, B AUE=0.7
J// W RYE3T6,  EE e, B ACE =11
/7 BB = G\ ) AR A8 17 A AH
/// </summary>
/// <param name="x">%\ ¥ {H </param>

/// <param name="y”># ¥|{f </param>

static double position(char x, int y)

{

51 MR R Hh 2R 7N B
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3. MAMRBIKEE (BREWRATE)

WA N A5 ool B 4 nl DU R I 5k el
DA HT B W 2 R AN S AR g s e g 2

S vt A5 M Ak Uy ik W2 5K, JATHE B MBI 2 SR K
AN, R W TSR, WATE R E D (20% ) 1
M M B R BLR E 2 (80% ) B FE o 78 Bl 4 i I ik K w] DL 2R
R, IR e Rk Bk B T ) B ok BB T AR g, AN b
096 TR E 1A% AR HEAE o FRATT R BT ek B H A s B0 7 S il B R
AN, B R B K

MR IF AN b3 48 6 1R 1 O, B i il b B 20 B e

AIBIC| |DIE|F
BN BN
B ..
B .
E-- -
EE
I EE., .
I
. —IEE
—— T
BN ... T
FE e | EER
FU{E | 1.8 1.2 |o0.9

BT e AT B, HE A AE T B s B, B A X B R AR
() ) 23 25 i 26 0 Oy vk ek 75 A Ik 4

ST AR 5575 1 60
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Fe a5 Jiik WIAX RAY TR

1 [REE R A 0 2. 88

2 [ REE R B 3 1.32

3 AAREEMR C 7 0.63

4 TREEME A 4 AR

5 TREEN R B A AR

Ve b R b T BLa S B BRI, BIR K
STk wevk A 2 W0 H B Bk AT It

4. MAABIKEE (AEWRATE)
A 0 v ik A R T e B R

000da0

0oooD Al F 0 0oDaootol ooooDch b

0012 oooaoamno.9
bl 0 cl

I][I[IJ]I]OI]2 0 0o0Daootol I]I][I[I[IlSIJG

Qo =
=

oooonoD 7 9

v
o oooemon1.6 oooDoaoo.z7z ooooaon1t.1
0 di 0 el 0 f

ooo0DooDo0Da0o=00T*0°Td 0

00o0d

BT e AT B, HOE AR T B st B, B AR X R AR
{ORERERETR: & A ODIRFn > S G IR WA KTF

ST AR 5575 1 61
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A EimiEhl WX FIAY  TiHA%
1 a. d A 0 2. 88
2 b. e B 7 0.84
3 cs T C 3 0.99

VE o SE B K R R b T DS PR . e . P /g A
AT G B B AR BT R A 5 VA wevh H E 2 Ik 0 2t A7 0k

5. BEAT 8 T R

1l 2 8 T 9 R

2, AT R T 8 AN A B, H ROk A A VSTS HL A
ook T

1. E 5%, BRI K% static double position(char x,
int y) b, sdlida s, St a0 R KT R SR

static double positionfchar x, int y)l

{ E EESItEO

double «i=1, +2=1;

if x=="4) HEH (R 3

elsevi f_ E}l{ E: “F |[u-;,| R Bl ). . |
vl = 1.8; - .

else if (x == "F') '=],, #fiAREET (T,

ST 2, SMURERB ).

2. deEE gl AT 7, R X AR

ST AR 5575 1 62
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R BT (2 X ]
HETEE C): THIEES (F) ~
B

v .JE Windowshpplicationl
v {} WindowsApplicationl
b O[g Farml
v.[7%8 B

Dﬁv buttonl Click (object, Eventhrgs)
|:| .;'V Dispose [(bool)
[] =6 Forml 0
|:|‘-:-.‘V Forml_Lead (object, Ewenthrgzs)
Dﬁv InitializeComponent ()
E‘V position (char, int)

b Dﬁg Program

b | {} Properties

FiHTE @) |@JE§EE¢J Visual C# MREIE. . - |

FIERFREY Wi=ual C# WEATHE. ..
BEG. .. A

FEMR] Visual Basic WHEILH. .. |
BIEERREY Visual CH+ JEIEE.

EXREEMTUER, CRIFEUMAREEHMMESSKH, HEE
F VS2005 G &y, FATM K 7 B A, wf PLIEE C#. VB, CH++#B 1]
LSz, X IE & VS2005 i k2 bz —.

3. A3k BT AT R e K, s e s i R X T A
H2WEHE

Fih T E B0 R

extFrojectl

| flEE || BLE |

4. NI H A4 R, sl A, AR Ry B IRE EAR
e AT A LR B R RS T A BLEATT NI A BN 1R A T i 4
W7 & G B L0 HE B o)

ST AR 5575 1 63
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AR ERIEEIEIE - TestFroject

= & E A
'_; BRAE Yindowshpplicationd
¥ % Solution Ttems

‘,ﬁl localtestrun. testrunc
B - . .

¥
- =d| Froperties
b [ 5IA
E] fbuthoringTests. txt
tl*;-‘| FormiTe=t. o=
t,i*_;| ¥iCodeGenhooessors. o5

AR 53

F B304 KK formlTest.cs B, X4 — B,

/// <{summary>
///position (char,

///</summary>

int) AL

[DeploymentItem(“"WindowsApplicationl. exe”)]

[TestMethod ()]

public void positionTest ()

{

char x = "\0 ;
int y = 0; // TODO:

double expected

double actual;

actual =

// TODO:

IR RSB N0k
P ha A6 3E 2 W AE

TestProject3. WindowsApplicationl FormlAccessor.position(x,

y);

Assert.AreEqual (expected,

actual,

“WindowsApplicationl.Forml. position RRMTHKME. 7);
Assert. Inconclusive ("5 UuF Bt 0 3 J7 v 1 1F #f P o

’y .

51 MR R Hh 2R 7N B
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IX A A B 0 AR R D AR AR A AR gy, RISk A BT — T
[TestMethod O1: BB T LU FARHD & — ANk I 91, 7E form1Test.cs
) “tregion PRI JE M7 HiE G R L2 WA RS 0I5 LR AT
15 )5 3 9F 3k

char x = "\0"; // TODO: HI4A1L K& 24 1 1H
int y = 0; // TODO: #4541kl & 24 (1 1Y

XA R RN S, FERMNEESLEMmME, WA
T ot B AT N W AR )

X R AT LLE R VSTSHS IxI T ¥ EH 0, Hylt T 4
o, FATEMAy, HEBEREMMEMITLL T, VSTSHZ) Jychardk
o BT g, Won AR R NP4 R RE AL -

double expected = 0;
double actual;

XA S R, T — )l e T SR A RN R e AT WD A
o, Ja— AR e LT R . XfexpecteddE 4T T W H =05 fx L &
0P8 M BT X L AR 2E IR N B AR AT DU AR I R SO M T —
—Z A M AN

AR NEN T ALk {factual B 4 £ ? N Iifi (X
) T A A AR e EAT IR

actual =

TestProject3. WindowsApplicationl FormlAccessor.position(x,
v);

KT, WAEMEMMEBEMC LRI T, ZX AT AT L
X7 T OACHY, R T IX R) TR A SE L T XA T RE
Assert.AreEqual (expected, actual,
“WindowsApplicationl. Forml. position ARERM P FHFEME. 7);

AssertfE X B 0] DL B b 5 . AE VSTS M i B oo Mk 2 55 T W &
F k. FEMSDNR ol b, A7 IXAE M HaR . “ nl g O« 92 B A A5
NHEELBNAE”. NEHEMEER, U H &%l A “when I do {x}, I

ST AR 5575 1 65
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expect {y} as aresult”.” [ H DA, W LLFH A LT X LW F .
B2 StringAssert 3= CollectionAssert 2=
AreEqual ] Contains gl AllItemsAareInstancesOfTypel]
AreMotEquall] DoesNotMatch(] AllItemsAareNotHull (]
AreMotsame( ) Endswithi(] AllItemsareunique]
Aresame] Matches (] AreEqual ()
EqQqualsTests (] Startswithi) AreEquiwvalent(]

AreMotEquall]
AreMoLEQUiwalent(]
Contains il
DoesNotContainl

Failri]
GetHashCodeTests (]
Inconclusiwer ]
IsFalsel)

IsInstancedtTypel] IsHotsubsetof(]
IsNotInstancedfTypel] Issubsetof()
ISHOTHUTT (]

IsNHUTTCD

IsTruel]

FHREKA ABEAE LB, B ANG T, RS A L
an i, FAT AR WA W R b, N IR CAL0D, TR O 2.88,
4 BLAE expected=2. 88, SLPr{H Eactual, FATINN
expected=actual Pl X A4 H@ i, Qo A S5, 48 <0k A A
a7 XA A s AR A R, I A AT A X A A SR
Assert.AreEqual (expected, actual, 73k H % AN L") ;
] SR B, T AR BT 25 Sk I ARl i o )
5 W SO AT %A RS AR

H# W

AreEqual oEH. IREENELREES: ARFE-ETEE. NIk R

AreNotEqual 2Ef. MREREMNEET A% NEAERE. AR,

AreNot Sane SEH. IRIEENMREESIRTREMAM SR MEFARAAES RBREFIE. TR E,
AreSame 2EH. METEERNMRETEES | RER MR NEFERANES AR R kA
Fail oEH. WEER.

Inconclusive BEE#H. ®TTRELELEHED true T false FALEER.

IsFalse 2EH. MRRENFMHESEA false; MREIEFHH true NARER.

IsInstance0fTvpe  EEH. MFAEEMMEIEHFEERNLF: MERFRRATIEIENE 4R ERSERP, N R,
IslotInstance0fType ELEH . MRIEEMNMEZET-EERENMEMA,: NETETERENTTIZN R SR B ERP, NNRE%R.
IsNotHull BE#. MREERNMEIEANET: WREDH F3IHA (FE Visual Baszic FH Nothing) » N6 ER.
Ishull oEH. MRAMEEANEETES T31H (F Visual Basic F% Nothing) : MEEFHET, WML R,

DUAE R B B )i — Ak
Assert. Inconclusive ("4 ik Jb I Bk 7 ik E# . 7) 5
MM ERMIRE L EM T, 45 “RALIKUEMA true o false
R S

mARAAEERICMK P mdr “wE” , 3 BN M
A S Rizid WAL XL W ED
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I Fr L C
LBiRTE ©): TS ) -
&

v ‘E Windowshpplicationl
v /| {} ¥indowsApplicationd

v-[ /|4 Forml rEnE
v % o
! |__| '_,‘V buttonl Click (obhject, Ewenthrgs) A @) |[FilelTest. cs
i D :}-V Dispose (booll HEZ (L) :tClass]Test
|j i Forml () : S —
: E|£"V Forml_Leoad (object, Eventhrgs) Figa . 'FMEthDd]TESt
: ij‘g'" InitializeComponent ()
L .: !EE‘V position [char, int) e
b1 3 Frogran 0 = i
B[ ) Propertivs [] BLA R TR S Rl iR A S
[V] BREHES )
[T =RFRERAZE @

[¥] BRIEEE @

HiHmA o) |_ETestPro_iect3 = |

LBEE)... | | omE || B
I B 2 H Sk B 5 o6 K gt K A Assert. Inconclusive (756 F b
WM IEMYE. 7)) XA . WRER, TATT a0 © Mk

AT WK #) 44 B

R 3 WA (0 08 A) 2 B, FRATT I AE At B o DK AR A, N B — A
W H

WAREA BIANX  EIAY T
AR R B 7 0. 84

[DeploymentItem("WindowsApplicationl.exe”) ]
[TestMethod ()]

public void positionTest ()

{
char x = "B’; // TODO: Witk N idE 4 M 1H
int y = 7; // TODO: )4k 1k k& 4 1) fH
double expected = 0.84;
double actual;

actual =
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TestProject3. WindowsApplicationl FormlAccessor.position(x,

) ;
Assert.AreEqual (expected, actual, ”=5ZPr1{H :

"+actual+” "+ HAEEA . “+expected);

}
MWl snse 7, BAVER —F, BEEGR: madizg it “Wik” >R

ke s H AR Cn R ED
i) | #Ow #HEC FEho
U #REEOE .
%o TNEETTEARICH ).
o GERFERIE RIS €.
by FREASREEHEERIIEEE @) Shiftalt+X
|°[> BEhEERIGENE CRRRE) 1) Ctrl+ShiftX |

N JE FATTAE e 1 PRl A R AR ] LUE B R BT s R &S

R

v DifiET: ESEe. £F 0 11 B EPHIE: o

. MRS me teimls 2
{,j@ koY positionlest TesztProjectd

Ml e ] LAE B A ka5 R Cln N B
positionTest [Besults] FormiTest.cs*  Forml.es  Forml. s [¥it]
BHER

MiEE%8R: positionTest
S o

FFEEME] ;. 00:00:00. 19TASOT
HEAN-5H5 . [4BTFCCCORIS438

FriEAdTE] . 2007-T-T 21:21:24
SEEEEE]:  2007-T-T 21:21:25
AR b ok 7T, HB Y H o Psh A
AMGEEHD? W, BEA K — FARM, #double expected =
0.84; M K double expected = 8.88;, RjgHMAT — WMWiK, FFH
IR
O WEET: AR SR o1 BT PR | EIEE

I BF it 5 8 e sz
W bj") e 11} positionTest TestFroject3 Aszert. AreEqual £,
B idi
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positionTest [Besults] FormlTest.cs  Forml. ez Forml. es [¥11]
EHER
MidE%R: positionTest
#®=8: i
FFEERTE]:  00:00:00. 7443047
iTEH S8R D4BTFCCCIBIS436
FrigETial:  2007-7-T 21:34:00
SETRRTIEl:  200T-T-T 21:34:02
77 ]
Assert. AreFqual £, BFFT: <5 88>, SEERAT: <D 84> SEER{E: 0.54 BAE(E © 5.55

i
IE TestProjectd FormlTest. positionTest () {E I:'‘Windowshpplicationl\TestProject3'FormiTest. es: i1 66

WG, VSTS Mk =, XMMHGEFHAD T E!

O\ R A A AT 3R
PUAE B AT 2L W A (1 8 A 03 1 4 0 A A Bk 4
FPol s Jiik BIAX Y U

1 HREM R A 0 2.88

2 HRAEN I B 3 1.32

3 HREEM I C 7 0. 63

4 TREMIE AN 4 HAAER

5 TeREEM I B ANEN HEOR
FH)s EaiEa) WAX EAY U

1 a. d A 0 2.88

2 b, e B 7 0. 84

3 ey T C 3 0. 99

Bk R, R EGURA R B A = R,
o5 N R AT T AR A AT BL T B R I pR B AL AN RE AT TR
He 32X HL5 YA I B ok 2 A BT

T3k MAX  EAY P

R A 0 2.88
HREEMI B 3 1.32
K AL

[TestMethod ()]

public void positionTestl ()

{
char x = A’ ; // TODO: HJuH4k Ky id 4w 1A
int y = 0; // TODO: ¥]4xfb Nid 4 m1H
double expected = 2. 88;
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double actual;

actual =
TestProject3. WindowsApplicationl FormlAccessor.position(x,
) ;

Assert. AreEqual (expected, actual, ”=5ZFn1H :
“+actual+” "+ Ml H: “+expected) ;

}

[TestMethod () ]

public void positionTest2()

{
char x = "B’ ; // TODO: #l454k lyi& 4 1114
int y = 3; // TODO: #]4s1k Jyi& 4 () {
double expected = 1.32;
double actual;
actual =

TestProject3. WindowsApplicationl FormlAccessor.position(x,

y);

”

Assert. AreEqual (expected, actual, "SEPr{H: 7 +
actual + 7 7 + "HWIB{: ” + expected);
}
o X AR, B P AT B I B A S N e, BEAT Ik, AR
W R, HE Gl & ).
Ky Be, bk JATH M KA — H !

PO R R B S B

{6 FormiTest.cs i 5 I XA, XA
VSTS H 70 M 2 98 K 1) b T .

T AT AT BLAEE L AT R TR AT B F A

ST AR 5575 1 70



U

o [ o www.51testing.com

tregion [t K B Pk
// 9 5 PRI, wr Al R R B s vk
//fEH ClassInitialize FEIZAT IR MW — AW 7y

o6 1a AT AR S

//[ClassInitialize()]

//public static void MyClassInitialize(TestContext

testContext)

A

/ /A
//}
//fEH ClassCleanup fEIEAT BT A MR G s

//[ClassCleanup ()]

//public static void MyClassCleanup ()

// A

//}

//MER] TestInitialize &3z 47 & AN Wk A7 56 12 47 AL
//[TestInitialize ()]

//public void MyTestInitialize ()

/ /4

//}

[/ TestCleanup 7E 42 AT 56 & A MK )5 18 17 4065
//[TestCleanup ()]

//public void MyTestCleanup ()

/ /A

//}

#endregion

XA AW ? mm, Hs e S WmBRHAa T, X8 “W
Fn Ik vk 7. BRI B v R L, B IR AT I v R T BLAE A
T. BEMKWEMSA: [Classlinitialize() ]+ [ClassCleanup() ]+
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[TestInitialize()]. [TestCleanup O 1. AAT AR £E &A1 L i )
TERBMOCAVMRNA T, EHEERZXRRNARITRIET .
W Z P ot R X A AT hg, BLIRZ BT WL, JE o 1 m ok i
(R 3 1
L2 —Hl, KFMaFHMARY A DA AT 58 W6 5 5 f
B A ER SO &, KRR OGS B ok B R R . ) DU SO k.
#region B sk Ja ok
// 9w 5 W, Ay AE T BLR B I e 1
//MH ClassInitialize fEizAT 2o I#55 — A L T
6 is AT A Y
[ClassInitialize ()]
public static void MyClassInitialize(TestContext
testContext)
{
StreamWriter m_streamWriter = new
StreamWriter (@”C:\log. txt”, true);
m_streamWriter.Write("Test Time,”);
m streamWriter.WriteLine(DateTime. Now) ;
m streamWriter.Flush() ;

m streamWriter.Close () ;

}
//fEH ClassCleanup fEIEAT B H T A MK G s

N

7 AR
[ClassCleanup ()]

public static void MyClassCleanup ()

{

StreamWriter m_streamWriter = new
StreamWriter (@”C:\log. txt”, true);

m streamWriter.WriteLine(””);
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m streamWriter.Write("Total Passed:,”);

m streamWriter.WriteLine(Convert.ToString(Passed) + ”,7);

m streamWriter.Write(“"Total NotPassed:,”):

m_streamWriter.WriteLine(Convert.ToString (NotPassed) +
oy
m streamWriter.Flush() ;
m streamWriter.Close() ;
}
//ER TestInitialize {53847 & AN MK A7 56 & 17 48 A4
[TestInitialize ()]
public void MyTestInitialize()
{
StreamWriter m_streamWriter = new

StreamWriter (@”C:\log. txt”, true);

if (actual == expected)

{
m streamWriter.WriteLine(”"Test Passed”)
Passed++;

}

else

{

m streamWriter.Write(”“Test NotPassed, ”);

m streamWriter.Write(“Input X:,”);

m streamWriter.Write(Convert.ToString(x)
+ 775

m streamWriter.Write("Input Y:,”);

m streamWriter.Write(Convert. ToString (y)
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” ”
+ ) :
b ’

m streamWriter.Write("Expected:,”);

m streamWriter.Write(Convert.ToString (expected) + 7,7):

m streamWriter.Write(“Actual:,”);

m streamWriter.Write(Convert. ToString(actual)) ;
m streamWriter.WriteLine(””);
NotPassed++;
}
m streamWriter.Flush();
m streamWriter.Close () ;
}
//fEH TestCleanup 1E iz AT 58 & A Wk )5 iz 47 4004
//[TestCleanup () ]
//public void MyTestCleanup ()
// A
//}
tendregion
[F 5] : using System. 10;
HHHJAS & : static int Passed=0;
static int NotPassed=0;
static double expected;
static double actual;
static char x;
static int y;
FF B A ) B X T x. y. actual. expected [ I M R
X g FATT A AT S, B S AE o\ E I AR K log.txt, A
K
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Test Time,2007-7-7 23:29:57

Test Passed

Test NotPassed,Input X:,B,Input Y:,3,Expected:,1.31,Actual:,1.32
Test Passed

Test NotPassed,Input X:,A,Input Y:,0,Expected:,8.88,Actual:,2.88

Test Passed

Total Passed:,3,

Total NotPassed:,2,

HRERFA U AR A s m e MMtaZZmt XM az
(3 5 ?

JR R AE . 8 log.txt B 4 N log.esv, B4, A LLH excel K 4T JF
(EO QI N OF

Test Time 2007-7-7 23:29

Test Passed

Test NotPassed Input X: B Input Y: 3 Expected: 1.31 Actual: 1.32
Test Passed

Test NotPassed Input X: A Input Y: O Expected: 8.88 Actual: 2. 88

Test Passed

Total Passed: 3
Total NotPassed: 2

RS b2 TN i H S N 2 1 4E
IR L A AN B SO IR e AR A, R I R
PE 7 e AT R SO B W K 5 3K (R R

4R
VSTS (¥ #7038 (1 Zh g 2 5 K i b ml O — B, A B8 7y 2 DA
SCHE A M 2 1 A 2w RESE N A A I, B Ve A
LV | S 7 U P NN A Qi N G -
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BRAT A T KK

B35 R4 82

WO WA G AR A HE E R BUG, iy B2 3EOK R % B R
Z W P BUG 1R 7 3k AN 3. AE AN RE $ Y 7 3 A0 300 I e, U R 40 A
21 R BUG 7 2B BT Ja P R R AE . s L BL BUG, tho2 Pk A 5 R0
AT o Al — A WK D3N % AN R A i R A o) R R B, e AR 47
AT R N B3 St N B3 BEAT 8 T8, 8 B PR R R OGS

FA@EE: Wk A s BUG

CRE I I BRME R AT JL R AR TT A7 bR OB 5] R K K
Mo A 05 FE R 2 5 BIDRE BRI 45, Bl R a0 0 R 0 A7k,
— HL A SR DR By B AR B A

M 06 4 7 B T a6 2o AR, 55— A AR IF AN 2 B I i 2
CEOPESEHE T BCE BRAT CBOR SRR, R JE AR T B . B AR
(K A X AT A WA 2 A, BT A SR
AN BE e LA AT e fg — 2 e, HRE B — A MDA AT BN
PR — BB AR 2
R LR 5 NS AW VA e S A A ST R e

T30 I N 2 RE 5 A T K AR R Ok, REE o BURR . AT
2 O 55 it R oK Bk 47 0K

BLAE 1B AE T e K 2 #8028 i ) & B T WEB 25 # I JT e, B B
A5G IRl A2 20 A . e BORR . AR b 55 IR 55 U RE 4%
WA S AR g A2 BEAT K. R AT IXAE A fiE 0% T Ok R
2 d o QS NGB 71 S T
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HT T A N N g5 50 AR S HF Bir BAUSE AR RE 98 A7 R A HT ™ (9 A 2
BRI BEAT AR o Lz IT AT IR 2 T 2 AH T

s HIFRN G E

AR ON B AR A R R BUG, i B2 B OK R AR
Z I ff P BUG IR J7 35 MV I A6 A RE $2 M 7 320 RSl 1) I ok 228
VE AN AR RE K AR BUG 7™ A R H S P AR 3R AF . fiE 95 HBL BUG, thE
Ml N EARTT . TFRANREH BT TS, ITUEA 3
MK BYRE S T . W] T RO OR IR BUG. R AE 0 45 AR AT A PR
& ¥ BUG # BT 53k, Al AT 2 i N 53 1 AR, i o7
Y SR RN (BPRF

SRR A P A U e 2R i) 2 o]

WARBEN T 25 2 00 B0l A2 B E P AR RS oL, R AT
I s DY SE AT M RO RN B . B, AR R I
FE b R O Bods v 0, G0 T g 6 R, w2 G ik i sk AE i B R
ANED, T R BodE AW R B, 30 3k © & IR il A7 il AR SR R
A m ERARI G K. [ -SRI RN, RN
SUAR PRt 70 A H 7 R 0 LI, O RE B A B R (Y I R) N X RE R E AT

NS 22 3, B BE ORI 2 v DL B — S8 ) S AR . JEAT R
P REIMAR N, T EMACE KA EE . EEERAFNIRE. £2F
A5 A £ BER 5 4 55 22 A O T K 5 R RO IR TR RE ) . i S BL S AR
P E &N T KR, B AR g B ain T, A
W )RR R A
U, fF B IX 4y BUG )™ 3R R0 AT 18 R

AT I DX IR R R TR, WA A BUG 2R, AN
TE S AE Sy R LR AR AR R I BRI . JF RN B B XA AN
A BUG, a2 XX A BUG BEAT SC M, 1fy BUJE ™ 22 A 8 "€ iy 552 02 A7 AE
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(K1 —/> BUG . H H B9 W A IT AN 61 B AR 32 47 5 0l & 1 — A iR X
M — 44 N B3 L S A I R BN B S B AR S 8 BUG 1™ R
JE R AL AE RS R A I H BT Al oK K 5%

Fov DR T R R R R I R Y

W ~al H LA 2, THERE. 12 30 H# 2 5H 4
11 o 5 W Bl 90 BEAT IR DR TR, R R il T B S B
OUAE X L A A E ST T o RS E0AE DA o R R R BE R
347 K o R A L Oy AN AR 2, A — S T A
AR, 3T KR R 5T 3 R AR R K 5T B

AN L7 B N T

SR FE T, WK THAAIANERE, — B ThEe 7 m
P A, O S T R g S A ) ok SR AT AR . A A T RE
W I 18 K 4 ] 31 LOUNDERRUNER.

PL B A NG LA B BOR ) — 22z, VAR A B SCE(H
AERXHKET M REAMIE, BTG JLA T BUK S 2] 7 06 28 2K
[N B N =SNGl PN A
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Bug A~ e B L B JR X 43 #r B 5t 5K

fE & . vk K

W OE: AR ESN T LB EIN Bug AR AR, 65 5 A
Bl D g VR RO R N N AR A i . XTI, AT T
HHONE R B o L X Le i, T LLEBLVR 2 LLAT A 0 A AT E LK Bug.

KA. HI; Bugs; B

RN IR bug Ja, mAMNBEEJNW L REEANHARE A
INVALID, REKRHEE X —E R Bug. JEXANREEFRT bug 1
Description J&, & A BE K4 RE R ok EI e, REMmm T
AR TELEREN Y., —HHWXFEREN, Wil &SR
Ly, FTEANGHSNMKANGTAGEENL., XRERRXRRZEKRAAE A
Rl BN BT N B 2 TR Ok R CE I Bk . R TR R Bk
F Il N s MOF R N Bk, B Tk Bl

N T DX SR B, AR A L B B — T Bug AREE I
D Ao AR 4l Fe i Il 2 56, Bug AN A2 I 5 R AT
—. HWEA

Xt bug ABEEF A& EE R . AEIT KN BIA Y IX S B A
1) bug B, vk 2D H 80%H Bug s B 3 HE A — B R i
(o 3 BE AL A5 JT A 34 355 A0k 36 58 19 A — 20, 8 O RO BT &R
g8 S8 b ds A7 B 8 R — 2

Bug /AR — & R EK, BEREILWSGEE RS R
B AT AR N B B BG4 R AT R AR E IX A Bug.

M SC SR UG, ORI B5E W &R RO AT AT D] B S A 8 . i
EAF R & AR E . MR . PO W, K
BN ZEAR: RS M Build. Application Server H 25 Fl Version.
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Operation System )i 5 Ml Version. W % 2% 7% 5 F Version &5 .

Mg R L) XA Bug U ILAE WebSphere
6.0.2.15 b, M IT & N 21 2K, 2 WebSphere J+ 40 % 6.0.2.17 )5,
I Bug Wt HahWH kT . Bk, Bt Bug & K4 WebSphere [ it A AN —
5| H .

JLAS B A2 A Build B A LW K T, WIJT 48 $6 5E 2 JT
KRN BB BN Bug 1M 51 B 53R . J5 R & R A7 41 30 Il Ak
W, JRRZBERENIEST R <R WK A 53R AL 28 1 45 4
Rl S AW AE T ST, JF RN ST e AR R .

Bug ] Description [ &t /> B Bl bug ¥ & dE#H 1K) 8 /E, F &
Mk & &8 A5 85 i — A Role I (Y 5T -

Role Detail Information

=
&2 Party attributes
Administration HR Domain Default HR Damain
HR Domain Manager Role Code I
Org Manager
9 9 Role Name
!
Default Calendar ID I 'l
User Manager
Description
LDAP Manager

_ Sae | Cancel |
1: 34 Role 1) JUIH

WAl N A AN s . R e R Save Ja, AL
I T java.lang.NullPointerException &5 1% o W — A /PhaDy, EH K
KA R LE PR T, IR G, RHW L
B AE Al Role T (4 4R B LA FEIN UL Bug 7). mAEFEMZ, HW
5 Role f XM VFZ DR i B EVR IR o RAE A BN A KET X
AMEER, VA EI L Bug, HEE R M Bug B =AM, WA R
&2 Bug A H Bug FEH XL T CHFJ5UEUIX Z AR U R 28
).
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FE 0 — /> Build B9 I A, 3-SR N B E AR T I Bug.
J5 KAt DBA W) #5 B N & 3] 7 4 6 Bug 1 5 IE Jit I : it A Role Code
J&, WER Role Name 4%, WHEAHETKAE (FERARAE): H
siili Save Jr, R @ ZEARAF B YE E T, Role Bt ) Table %K
Role Code F1 Role Name # A f8 N = ot o T

java.lang.NullPointerException X 4~ & i 5 & .

2 Bug KAEMWRKE, NI K A i Role Code 4 1E
Role Name, I M /' %1 A Role Code 1j % 5 %i A Role Name. £ i
MWAKX, M Bug it fFtASHIT .

T IH 2 BB bug 1 5E Py 8l oK -

[Step]

1. Add one Role on Role Manager;

2. Click on "Save" button to save it.

[Result & Memo]
One error message appears: java.lang.NullPointerException. As
a result, I could not do any operation on “Role Manager” tab.

This bug appears even after I restart the application server.

I cannot reproduce this bug. Please describe testing scenario in

details + attach error logs.

[Step]
1. On ‘Role Manager’ tab, Click on ‘Add’ button;

2. Enter one valid role code and click on ‘Save’ button. Note: you
are forbidden to enter any value for ‘Role Name’ in order to

reproduce this bug.
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Now there is one error message on the page when clicking on

‘Role Manager’ tab.

[Memo]
According to the schema TBCN_WF ROLE, the ‘Name’ column is
forbidden to be null. But there is no code to check it when such

occasion happens. For detail information, please view the attached

file.
To avoid this bug happening, I suggest you set the value of “Role

Code” as “Role Name” if such occasion happens.

Fixed in build # >= 484
0 WRAENAHRE

Xt T Web I3k Ui, TE (1 B B G2 X 5 Bug 2 A7 52 {19 15 1
LA B BT T B A LA K
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1 2] x|

B =2 |mR | AmE |EE |2 | Em |
- 2|
Ny BRERRE TR
BN & RS )
i | BED Internet Explorer BT4EEE (3]
i Bshial |
= ¢ TARE ) iy
—Internet I[fGETEC L

HHIACE C:%Documents and
Zetting=tAdminiztraterhlocal
SettingshTemporary Internet
Fileczh

F TEFAIRIERESE] (D) =

1
== oes=1  mME
e

e, | ZExnw.. | =EH2 Q. | |

. TR ms | ||

wmE | e | =Ee |

K 2: Internet Iffi IFF X4 1 X &

Internet 3EIN

| =2 |BR | ms |EE | EF  =EE |
HE (5]

O =5 ,
il “HEIEFEY 0 Ui PR R ERAERE A R
O =51 ERELEE,

BRE=FHKEEST B FEEE2850

O BRA-I-tikdmEes e

BRENIFEZ%: (Internet Explorer)

BHRHEIF=E H =)

O sE=hEREEEE » Bl EEEEiRlES s T (maea gsh
[ A= FTF CHEAIET DL (AslEE R =)

1B &=

[ FRE#FWG A B=b>sEThEE

B 7 FIP b5 AT e

O T#=pEEHIBAN
ST B g =AY E
Fl 8= FIF HTTF #2128

1 | | L[
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B 3. g I E

LMY AE g dE b, il AR o AR IR D
WK 7 AR, BT oA Z A 2 M« o B A A B R g
CiEFee, RIVHT i 2 0 82 ).

X0 B AT R MR BT IR 10 Bug 2 HE EE KA . MR
S0 A B R 0 g, T N B a] DO R BACHE R B R, T I
B,
= WAFIllEE

RERGRKWEAT F MR ETHES . cVIBRIEISR, Hh
A E R D 2 A A R . A R TT RN R SR I [ A
710 2B, 45 R R GUAE A W b Hil N A7 2], AT A A R
RRMIRAEPAASHE, BIHRGK P ti, JFH
Mt 22 51 A — R AU R 8. e 2 i) 0 AT 28 K ] ) ds AT s
Al RE = R B .

IS e A BRI NI

BEOS AR B AE DL L, JF HAE LR B e I B B I, — B A A A
AREBFNAEEARAEI. RERVHBEHE W ARG B R, K
AN o BB VR s (H AT L8 MO e A I A o TR A A S Ak — Bl R Al
KA, o I — S AR R DR . A A I R I O S R B AT T g
KA

BEAR 23 A1 T X 2% Bug A BEE I AR K, FRATT WL AT LAXEE T 24

Lol N G2 2 A A5 1 = B, JF7E Bug Report H (i 14
TSk 0t BA B E R, Hr o0 a2 52 i B L UL Bug B I8 48 A 05 DY E .

2. Bug ) Step ZEHEM U WAL . O 7T EI — A Bug, Wik
A 51 A] BE 75 A JL A Build #F 47 3% 22 BR B 00 A E A7 7 AE X S Bug
) e AR A J A
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3. 1F fff B0 BB A I 3 0.

4.0 M RE AT E ORI R R G e AT KO far R
(Loading Testing ), UL B A7t 5 &5 75 22K Wiz 17 4 g 201 i)
Ao MR WK g, i AP el 72 N I s et T
AT 72 /NI S H B ) R AT RE L A T e DR e R 0 R
AT 72 /NI IR i Il BT

5. A BN AR I — R R AR KRR A UL

6. WA N REEIT K A G . DBA S RIFMALR. B3 H M
TR g HMmATE, Ur B AT E W . AT AR, R
A LLHE Y S Hb 4R B ) B OG B T AR 2 A .

AR BT X e W, AR K 2 B e L) Bug #8 AT DL
T URETWAMAREMITFRES . TR PEERRZM AR,
MERANRE— —F 2 W EEEND Bug KAEFTARKE. W RickiE
PR LY (. K X VLR EIA Bug, A th RN, AR AT LU %
HECR P R AR 2 A R A Bug 1R

1. BB 142 Bug Y RE IR R0 T A (0 B0 056 DR 38, — 22 — = (¥ 40 15 4P
ANEAE .

2. 5 K NG, DBA. R Wi A G, T H & B — i B
SO IR BE M B, MR DUAE & 5 40 A W it Bug LR 2R %, JF
75 AR TF) 1) 2R B8 b e 26 TR R 1R &R g8 30 AT WK, DL 3R UIE BT A1 R .

JiAh, X TR EEY . A ERE A RIR S Bug, WL
B R AR AL KB AN I 200 R TFIRX
BT, A KR A R A R R BT S AR R BE ML Bug. WA
IR R, A AR e O IS — 8 AL )6 2 B B 0 AT A
mEEvAE R . HES., XFEWRFATIFRANREAM. e,
DN AN VA i3 2 = oq (| B7 S C  V 4 I7 NNA B Ay A £ 1 V7 1
AW EE, JEEE M S I RN SRR G4 AT N B B AR )
LI DR RN e T ik
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CUnit Framewor 428
& : RIL

¥ E.: 4k Junit CppUnit (Y5, CilF 5 (C/CHH)IEE R H I T IF K
R B &I H A CUnite CUnit LER S ER RN MEGH PR, HRP
O 5 RE e RN B R BE R RS AT DL T o e R A T — A R R oo It
HESE, JF H O 5 T S i 8 R 32 1 7 = | I W 5 18 A SCHF o A SCA I X Cunit
R SEBRAE T, 5 —miof.

KB F: CUnit; oIk ; TestCase

1. CUnit Framework 44

4k Junit CppUnit I Ih )G, c i H(C/C+H)HEE N BT I
RS A &K H #1 CUnit.  CUnit BLER S 22 (10 2 203 45 H P
iR, AP a@mERP RNk EEEREEHFSERTL T BftT
—AN R R T R HEZE, I B W T Bl SR AR T R M
HWEA L. T4 —F CUnit 45 8 HE 38 F0 2 4 A -
1.1 SHESR

f CUnit B 3 50 & A] LU 30 Al &5 K fi] 5 48 8
Test Registry

Suite 'l" Ce Suite 'N'
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| | | |

Test '11' ... Test '1M' Test 'N1'... Test 'NM'

CUnit K 2 8 &R 3, Jae i — AWl ] ] Test
Registry, — &K MK ( Test Registry) 7] LLiz 47 £ ANl ik B ( Test
Suite), &AW 4w LA HE 2 A4S 0L B (Test Cased, AN
BB XA E AR HFEZ AW EFRMEY. RAEIBRPREH L,
— AR R 5 2 A Test Suite, BN N TR &AM E S, A
Suite & # £ 4> Test Case, EXF N FHH N & B LI . B4 Suite
A LS A setup H teardown PR EL,  J3 A AE AT suite B AT S I A .

T — A 00l ) (an 2R 2 &M T AR AT BL cleanup 5 4R )5 EOHT
HEMAE )R JE CU_add_suite 3 I /R B AL EL 4R 5 CU_add_test 5 7E IR
HORL S N R B N Bl e . P R ECE B e, T AR
REUAE 0 S T AT I
1.2 WK

T DY Al gk A
I. Automated Output to xml file Non-interactive
2. Basic Flexible programming interface

Non-interactive

[98)

Console Console interface (ansi C) Interactive

I

Curses Graphical interface (Unix) Interact
WAL, 2 EEALLYAEN, 4 K Unix FHIIKRE windows H
Jr, PR 3 A4 console 1 H console #& Al BLAMLAZ B[ .

1.3 WA 2 A R

i CUnit ZF 47 0 79 56 A 3 72 G R T o
1) BEARMK AR E Cn 2, TS suite 1 init/cleanup K £
2) ¥4tk Test Registry - CU_initialize registry()
3) MK AL (Test Suites) SN A #] Test Registry - CU_add_suite()
4y AN ) (Test Case) FW A 2 - CU_add_test()
SY ff H & M om B o0 kg oo oW R R, # W
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CU console run_tests()
6) i % Test Registry - CU_cleanup_registry()
1.4 TestCase [ # &
— /> C Unit TestCase ¥ i 5 L N X ff: test.c. testcase.c. M
ain.c 5 Makefile #J i .
BT — A~ 4k v ) i QO A 0 pR K, @ Ik ek A CE S IR B A
WA, @247 Wk & % K& @ Makefile VY FE 73 4 il o

2. CUnit Framework [f] % 3%

2.1 CUnit Framework B T #
Cunit Framework I 2 A it A< Jy : CUnit-2.1-0-src.tar.gz.
2.2 CUnit Framework K % 3§
CUnit f) Framework ) % 3£ JX 35y Fedora 5. ¥4 W T
1) 4
#tar xzvf CUnit-2.1-0-src.tar.gz
2) ghiEly i e
#cd CUnit-2.1-0
#aclocal (if necessary)
#autoconf (if necessary)
#automake (if necessary)
#chmod u+x configure (if necessary)
#./configure --prefix <Your choice of directory for installation>
#make
#make install
3) n# CUnit ] & (only one time)
#cd /usr/local/lib
#ldconfig
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3. CUnit TestCase ¥ 5%

4.1 CUnit TestCase fJ ¥ &
— /> C Unit TestCase MM A LL ~ L : test.c. testcase.cn M
ain.c 5 Makefile #J i .
4.1 CUnit TestCase F Z= #J B B £ % ¥
LR BL— > 8] B 11 testcase & 1 Ut B
T B ) A B K dr KAE 1 BR 2L maxid, I AE H 0 R SO A AR
1. test.c: HZ PR 2L (& X maxi()ek )
2. testcase.c: Wik pR & Cag SCI K A 91 A0 4k 40O
3. Main.c: 15 17 MK % £ (I A CUnit ) Automated 2 1135 47 Wl i)
4. Makefile : A S FE T
1) #%0 p& %L test.c
JE*
*file:  test.c
oy
int maxi(int i, int j)
{

return i>j?1i: j;

2) ks 2 Cor SO AR A B T IKEL )  testease.c
#include <stdio.h>

#include <stdlib.h>

#include <assert.h>

#include <CUnit/CUnit.h>

#include <CUnit/Automated.h>

#include <CUnit/TestDB.h>

/**//*---- functions to be tested ------ */

extern int maxi(int i, intj);
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[*¥*]/*---- test cases --------------oo-- */
void testIQJ()
{
CU_ASSERT EQUAL(maxi(l, 1), 1);
CU_ASSERT_EQUAL(maxi(0, -0), 0);
b
void testIGJ()
{
CU_ASSERT EQUAL(maxi(2, 1), 2);
CU_ASSERT_EQUAL(maxi(0, -1), 0);
CU_ASSERT EQUAL(maxi(-1, -2), -1);
}
void testILJ()
{
CU_ASSERT_EQUAL(maxi(l, 2), 2);
CU_ASSERT EQUAL(maxi(-1, 0), 0);
CU_ASSERT_EQUAL(maxi(-2, -1), -1);
b

CU_TestInfo testcases[] = {

{"Testing 1 equals j: ", testlQJ},

{"Testing i greater than j: ", testlGJ},

{"Testing i1 less than j:

", testILJ},

CU TEST INFO NULL
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[*E[[*---- test suites ------------------ */
int suite _success_init(void)

{ return 0; }

int suite_success_clean(void)

{ return 0; }

CU_Suitelnfo suites[] = {
{"Testing the function maxi: ", suite _success_init,
suite success clean, testcases},

CU SUITE INFO NULL

[¥*[[*---- setting enviroment ----------- */

void AddTests(void)

{
assert(NULL != CU_get registry());
assert(!CU is test running());

/**//* shortcut regitry */

if(CUE_SUCCESS != CU _register_suites(suites)){
fprintf(stderr, "Register suites failed - %s ",
CU _get error_msg());

exit(EXIT FAILURE);
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3) Z4TM 2 Main.c
#include <stdio.h>
#include <stdlib.h>
#include <string.h>
#include <assert.h>

#include "Basic.h"

int main(int argc, char* argv([])

{
CU_BasicRunMode mode = CU_BRM VERBOSE;
CU_ErrorAction error_action = CUEA IGNORE;

int 1i;

setvbuf(stdout, NULL, IONBF, 0);

for (i=1 ; i<argc ; i++) {

if (!stremp("-i", argv[i])) {
error_action = CUEA IGNORE;

}

else if (!strecmp("-f", argv[i])) {
error_action = CUEA FAIL;

H

else if (!stremp("-A", argv[i])) {
error_action = CUEA ABORT;

}

else if (!strcmp("-s", argv[i])) {
mode = CU BRM_SILENT;

H

ST AR 5575 1 o4



U

2o st M www.51testing.com

else if (!stremp("-n", argv[i])) {
mode = CU_ BRM_ NORMAL;

b

else if (!strecmp("-v", argv[i])) {
mode = CU BRM_ VERBOSE;

}

else if (!strcmp("-e", argv[i])) {

return O;
b
else {
printf("\nUsage: BasicTest [options]\n\n"
"Options : -1 ignore framework errors
[default].\n"
" -f fail on framework error.\n"
" -A abort on framework
error.\n\n"
" -s silent mode - no output to
screen.\n"
" -n normal mode - standard
output to screen.\n"
" -V verbose mode - max output

to screen [default].\n\n"
" -e print expected test results
and exit.\n"
" -h print this message and

exit.\n\n");

return O;
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if (CU initialize registry()) {
printf("\nlnitialization of Test Registry failed.");
}
else {
AddTests();
CU basic_set mode(mode);
CU _set _error_action(error_action);
printf("\nTests completed with return value %d.\n" ,
CU _basic_run_tests());

CU cleanup registry();

return 0;

4) Makefile
INC=-1/usr/local/include/CUnit
LIB=-L/usr/local/lib/
all:  func.c test func.c run_test.c
#gcce -o test $(INC) $(LIB) -lcunit $
gcc -o test $(INC) $(LIB) -Icunit s
clean:
-rm -rf *.0 test
4.1 PRAME
CUnit - A Unit testing framework for C - Version 2.1-0

http: //cunit.sourceforge.net/

Suite: suite success_both
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Test: testSuccessl ... passed
Test: testSuccess2 ... passed
Test: testSuccess3 ... passed
Suite: suite success_init
Test: testSuccessl ... passed
Test: testSuccess2 ... passed
Test: testSuccess3 ... passed
Suite: suite success clean
Test: testSuccessl ... passed
Test: testSuccess2 ... passed
Test: testSuccess3 ... passed
Suite: test failure

Test: testFailurel ... FAILED
1. ExampleTests.c: 52 -0
Test: testFailure2 ... FAILED
1. ExampleTests.c: 53 -0
Test: testFailure3 ... FAILED

1. ExampleTests.c: 54 -0

WARNING - Suite initialization failed for suite failure both.

WARNING - Suite initialization failed for suite failure init.

Suite: suite success_but failure clean

Test: testSuiteFailurel ... FAILED

1. ExampleTests.c: 49 -0

Test: testSuiteFailure2 ... passed

WARNING - Suite cleanup failed for suite success but failure clean.

Suite: TestSimpleAssert

Test: testSimpleAssert ... FAILED

1. ExampleTests.c: 63 -0
2. ExampleTests.c: 64 -!1
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3. ExampleTests.c: 65 -0
Test: testFail ... FAILED
a) ExampleTests.c: 70 - CU_FAIL("This is a failure.")
b) ExampleTests.c: 71 - CU_FAIL("This is another failure.")
Suite: TestBooleanAssert
Test: testAssertTrue ... FAILED
a) ExampleTests.c: 79 - CU_ASSERT TRUE(!CU TRUE)
b) ExampleTests.c: 80 - CU_ASSERT _TRUE(CU_FALSE)
Test: testAssertFalse ... FAILED
1. ExampleTests.c: 88 - CU ASSERT_FALSE(!CU_FALSE)
2. ExampleTests.c: 89 - CU_ASSERT FALSE(CU TRUE)
Suite: TestEqualityAssert
Test: testAssertEqual ... FAILED
1. ExampleTests.c: 99 - CU_ASSERT EQUAL(10, 11)
2. ExampleTests.c: 100 - CU_ASSERT EQUAL(0, 1)
3. ExampleTests.c: 101 - CU_ASSERT _EQUAL(0, -1)
4. ExampleTests.c: 102 - CU_ASSERT EQUAL(-12, 12)
Test: testAssertNotEqual ... FAILED
1. ExampleTests.c: 111 - CU_ASSERT NOT _EQUAL(10,
10)
2. ExampleTests.c: 112 - CU_ASSERT NOT_EQUAL(0, -0)
3. ExampleTests.c: 113 - CU_ASSERT NOT_EQUAL(0, 0)
4. ExampleTests.c: 114 - CU_ASSERT NOT EQUAL(-12,
-12)
Suite: TestPointerAssert
Test: testAssertPtrEqual ... FAILED
a) ExampleTests.c : 121 -
CU_ASSERT_PTR_EQUAL((void*)0x100, (void*)0x101)
Test: testAssertPtrNotEqual ... FAILED
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4. ExampleTests.c : 128 -
CU_ASSERT_PTR_NOT _EQUAL((void*)0x100 )
(void*)0x100)

Suite: TestNullnessAssert

Test: testAssertPtrNull ... FAILED
1. ExampleTests.c: 136 - CU_ASSERT_PTR NULL((void*)0x23)

Test: testAssertPtrNotNull ... FAILED

1. ExampleTests.c: 143 - CU_ASSERT PTR _NOT NULL(NULL)
2. ExampleTests.c : 144 -
CU_ASSERT PTR_NOT _NULL((void*)0x0)

Suite: TestStringAssert

Test: testAssertStringEqual ... FAILED

1. ExampleTests.c: 155 - CU_ASSERT STRING EQUALC(strl,
str3)
2. ExampleTests.c: 156 - CU_ASSERT STRING EQUAL(str3, str2)

Test: testAssertStringNotEqual ... FAILED
1. ExampleTests.c : 168 -
CU_ASSERT_STRING_NOT_EQUAL(strl, str2)

Suite:  TestNStringAssert

Test: testAssertNStringEqual ... FAILED

1. ExampleTests.c: 181 - CU_ASSERT NSTRING EQUAL(str2,
str3, 4)
2. ExampleTests.c: 182 - CU_ASSERT NSTRING EQUAL(strl,
str3, strlen(strl))

Test: testAssertNStringNotEqual ... FAILED

l. ExampleTests.c : 194 -
CU_ASSERT NSTRING NOT EQUAL(strl, str2, 2)
2. ExampleTests.c : 195 -
CU _ASSERT NSTRING NOT EQUAL(str2, str3, 2)
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Suite: TestDoubleAssert

Test: testAssertDoubleEqual ... FAILED

1. ExampleTests.c: 205 - CU_ASSERT DOUBLE EQUAL(10,
10.0001, 0.00001)

2. ExampleTests.c: 206 - CU_ASSERT DOUBLE EQUAL(10,
10.0001, -0.00001)

3. ExampleTests.c: 207 - CU_ASSERT DOUBLE EQUAL(-10,
-10.0001, 0.00001)
4. ExampleTests.c: 208 - CU_ASSERT DOUBLE EQUAL(-10,
-10.0001, -0.00001)

Test: testAssertDoubleNotEqual ... FAILED

1. ExampleTests.c : 218 -
CU_ASSERT DOUBLE NOT EQUAL(10, 10.001, 0.01)

2. ExampleTests.c : 219 -
CU_ASSERT DOUBLE NOT EQUAL(10, 10.001, -0.01)

3. ExampleTests.c : 220 -
CU_ASSERT _DOUBLE NOT EQUAL(-10, -10.001, 0.01)
4. ExampleTests.c : 221 -
CU_ASSERT DOUBLE NOT EQUAL(-10, -10.001, -0.01)

Suite: TestFatal

Test: testFatal ... FAILED

1. ExampleTests.c: 227 - CU_FALSE

--Run Summary: Type Total Ran Passed Failed
suites 16 14 n/a 3
tests 35 31 10 21
asserts 89 89 47 42

Tests completed with return value 22.
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4. TiH CUnit TestCase [ 1E &

4.1 T H  TestCase 1F 1% i 45 5 48
CUnit [ TestCase 1F % [ 45 5 M AH . TestCase Fl1 I H ALY 7> IF,
YE 1% 1) TestCase B A7 Hb /8 o H & vp o
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32k BR MY 22 [y BE

fEH . #EN

KEF: W Bug; WML RM; QiE L, BeFS

1. FHB

HOE, ME A — EAE P g% ORI A B WK A T AR T LA
Lk, RELERXILEN TELTUAERSUFEINRFSLS X
KOy F . A HARH B — 2o NI HE IR 1 K RE A IO S R
ey — AT, D — SR B K R

Ei E NS R A= (0P o= I R (S S A D R R (RN A e
BETF BB P TTBR oF AL M 4% BL Rk AL 2% Sl {5 2R AR, iEIREN R
IR R T — RS S R B A, Bl 2 &Rk a X
Fo WML ETE IP 7 WA RGN ME A aE TCP, UDP B X ). 3K
52 [ I DA) RN 7 HR AR T R P R JT R b, W Delphi MAZIFR T
— ARG MIS 24, M Linux+Gee+Gdb+ UDP JF & T — AN Bi 1)
QQ J5t 1y B I 50 R B A .

— R BT KR T, YRR TAEMAEEE. —EHERL
G N 3 = I O LN RGNS - R o A7 g
Wi CRRATIE R A E BRI, MR R A A DR 7 Y AR T AR
B, LAk e o b X KA WY AR AR R b X AR R K, A
JRHR Y AR R A TJF S T R S w1 BT LA, 4 S AR 0 R N 1
TR, SRR RENRDFLIMERKL, ERAENME
DLR, RIIM IR TR M AF . BEAEKNKE %, &S
TOM 2 A A ST AR B N, X S B I A& E B
B Fh AR E—IL 10 NAL, T H R AR AR ES 4N
PWAE, WARKEAHIMFRIE,
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2. “FHEME”

fEBE S 2 AW Mg m iR U, s — I BB A . T
Bl VOIP W2k HAF W&, EM B W AIRES T4 H N B %2 .
B AT o Lot B R AR, R b8 R IFMR, — H R EIM B o1l
Mo HoWRERFSEH TR E 128 BFREFE -FHEB ALK, K
KRN RHATERFE R, A L TCP/IP VM b & — A LI
R HIRE L . Bl STRERAMPBEMNAEL . TAHMN 1 RTT
G — E B MR 11 AR B LR, e AN G — AN %,
SOE S & — HEAMB M B 11 A FHBK. il - HAERFT 24
JIW I, B R AR 20 B & i, B BV . R IR KR
Ew R, DA R,

LA M, R TEAREZHBAAE"Mm&. B E
Br I I TR), H AR T e 1) B M PR, W SR R B BLZR ),
b TCP/IP VEfE A 2, PrEAJL-F A — D N SR B WA ™ 4.
TSy 3 A4 A F AR B T ORAE A, WIRE R R B Sk
I

JNH A — ki g2 7 AR E R TSR, BAE ™ il
WA K FrameRelay thil (B yX & — AW E, prildk—H & A
WS XA ST, HFERALFEN DB 1, =
g LS A |18 B (L] ¢ T FrameRelay B U301 i) @ #8 % b 3K fig
e, HRAFXANHWM LK KT ARENE 2 AL, Tl
MPIXFE—ANESR, BB R MR T — R B . 7R AUk A
Pz B B KH A AT R B LR

B oA BL, O B B0 8 B R A AT T SE B ) 8k #R L L
P At MR . AEXZDIW AT, g
A bit A AR O BT D, B i T A 7 b A FPGA £ HDLC
BN WP A LR B AT TIWAE . Bl R s B AW Y
R A, AL FENE B T LIRS — i, "R
ST 6 AR Y AR AT 5 FrameRelay Wil 5 B9 T 3 0 A 1) 1,
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3. “BREMFZ, —EKLEH bug”

5 A5 X 2 A ) B, oS MR B R KR T O IR AR A
Wk AN, AT T T 3 ARG, oo s 2k b Ik E
WA R, A a0 &, B T AR, Ak F ol i
e KM/ AERXI, WO IR RIS T AR, B A AL H
EARM . F—&KEML T 5K FrameRelay B, &AL —4
bug, ZHI O KM T XA EEA buge IEHKELN, &
SR — ) A T 3RO R IR AR AL, B B BT bug”.
T, WHERELEOSE, MAHMARAETACKE®. WA
G R bug 77 XML, 2| FrameRelay W 81 Fr A SE 81 J 24,
o H O X R T 10 AFr el oy M— L3, KT 4480
EEHRIW T — A — 2% bug, — A =2 bug. MNILLLJE, &30 ol
W BEERETHRAEER S A, A8 2 6t ae b =/ A%
{1 T = 8= O S (R s I 7 e S W e WPV (i e
e T AR, T H R RO S B B3 M RE D i AR

HAREIAT bug WIRE, WHMGERXAW: “—E&H bug”.
HERRERMEE, — &K bug K. “REHFZ” il T IEL
Jo BB i T e 2 B A aE . AT IR N B, BREOR I AR AR 2
XEHOWRK —XHkik. X, BCEWNNEA bug T, SRl
HOREWESMEEERNTs), XK THK bug. X AU L
0 X 25 R BE Lk IRk — 0 A A Bk L B3 PR BRI K T AR
no 2

I 1R TAES, oy FE R BRI KM mae ), o
A) Ay B Ak J A K TR O R AR, EREL T IX A, [ R
g 7N (AREE) BEERMNFN AT ARIT K TR offer. &
b= R 81 [, W7 | = A S A /AN < s i = 3 e s 67 U O
BEAT 61 3 1 T ok P UK o B RE AR JhOBE % Al B JT kR BE R
I IE) 7 Al 250 2 7 s ER D RE S BL I 40 Y, BEXS R T M) £,
iILECABEEIWE, EREINENSAK. XWEERAAEE 3 F
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% I I R 11 2 0 46 0 e G LI T e 4 5T T LB R I
THR. G RA DMK, RV I SR R L, e
0 4 R R BT TR R LTS R A A R LA A B
Tk, G AL PTLL, RO R TR E £ A

4 CWRBRR

2 R B K T 4 B 2 R 2

R L AR RILN bug HOE S BRI E, AR
CREETES T2 S TN G E N Y P[RS
it 5 o RN B 0 S AT P R B B I O
AR 0 K MO B A 20N 003 P 0 4R 1 BT 7 %, F HL A
A7 Al SR BT LS G R ) . SLSE E T R 9 0 4 T 1
R 5 O ) B 0 B0 L AR T BB B R A BB
it fig R BLAR 2 7 19 bug.

7 00 8 A7 2 7] S A IR R A

WG 1: 4700 BT 50 B A e, B, T LA K
BUHT bug BOHCR AR o BN A H A SRR, AR A 8
B bug T, 1AL B IR

ROOF R 1o FE T BB ACE H A bug, FUR I B 4k 5 M R 4
fFo 20— BOAIRH LB BE I 5E T, N IE A 49 30 11 5 813 )
EBL o AN A E TS S BT I B 9 18— R B
W5 5. RILT B bug. WRIGWS kT H A, A
10120 — S £ 19 80K K 10 4R 7

W 22 470 BT G0 BEYR A B BB, B, B L
B R ILVE S bug. [LRE, 3O # R A A, TR &
7 4 7 UL I 40 BT 001 3 PE R 58 %

ROOF SR 1. BAKRIT M E bug, (12 R {5 g il L ™
BB, MR % 2 bug Ak & B H BB K B
bug HCIKK M Ah . A SRR BRI release 3 KA, 24
RIVEE — %, % bug. 2. SR A O 4 T A 63 )
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KIS bug, A WAL FT KA bug B HANME . X F 70 0 R &
A AT FLOE AR B 0 K B A A R S A, IR
ARG AR RS, A ERZET T ZREERN bug,
5. REgMTE

B Ja 3k K 5L A) Fook T 1 & vk

JIN
2

(@] e~ w
P J P

-
4

WiEffe, — i bug.

DA I — A MR ™ o S8 2 B AN R 3 ) R AR

WA RE ik R BER PR A 2.

I BE AR AR B A L A A 23R

I e B8O R B i ) .

I BE BE R R IO PE RS, R AR — A B B B RTINS
K RE Lk R EE W T A E A TR B R S
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HREAMKX T RETHEFRIEN

E#H . K&

Z WA bltesting Ry [FEAT i3k QQ, Ak — 2 28 ot M3 0 743 LA
R TAEL R, B B A AT HS 25 in) 3 — A [R5 RE (% 100 0« R B A 2 00
TR, EW, A A AL AW HE T, R 2 N AL
A i s 3 Al Rl W 17 o B = (E WP £ 7.
R 5 — T2

FARMGET MWL TH, HimliL TR ERL, HM
KNEATBLgy e 2 A, —# o B ek sl 4l Bl ol T H, F2EH KK
MR winrunner, loadrunner %5, S —Fhat 2L H T H, £
SE I AR R ) 1) A B DL A bug BB BRI T H

FCO A TR 53R CAE G R, AR IR XA 2,
AT 56 B A A2 L WK B AR, B O TR LR R P
BRI BAT R R AR, P LR 0 H R IE R A . N T
& F I H R, AR BRI A Ik A S T R s,
WA H B e AR . H T A KR S R A kA 2 DL oy
P I R PR AR TR A KR W IR ), B AT B R
T8, JCVEORUE G B2 7 (0 58 4 2 55, [ i B 0 Ak G vk AR E AR N R
BE AE W3R p R LA AN Al N 1) bug, B RCAR HE A R I e R AT S L
SIER 7S TR W N S WL S R e e R R O 7 S I WUUR TR
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